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License Agreement 
 

END-USER LICENSE AGREEMENT FOR 
QUIK-PRICE BUILDER 

 
 
IMPORTANT-READ CAREFULLY: This Quik-Price Builder End-User License 
Agreement ("EULA") is a legal agreement between you (either an individual or a 
single entity) and Irrisoft, Inc.; it’s owners and agents. Quik-Price Builder 
includes computer software and associated media and printed materials, and may 
include online or electronic documentation ("SOFTWARE PRODUCT" or 
"SOFTWARE"). The term "SOFTWARE" also shall include any upgrades, 
modified versions or updates of the SOFTWARE licensed to you by Irrisoft, Inc.   
BY INSTALLING, COPYING OR OTHERWISE USING Quik-Price Builder, 
YOU AGREE TO BE BOUND BY ALL THE TERMS OF THIS EULA. 
 
SOFTWARE PRODUCT LICENSE 
 
Copyright laws, as well as other intellectual property laws and treaties protect the 
SOFTWARE PRODUCT.  The SOFTWARE PRODUCT is licensed, not sold. 
 
1. GRANT OF LICENSE   
 
This EULA grants you the following rights:  SOFTWARE - You may install and 
use one copy of the SOFTWARE PRODUCT, or in its place, any prior version for 
the same operating system, on a single computer.  
 
Storage/Network Use: You may also store or install a copy of the SOFTWARE 
PRODUCT on a storage device, such as a network server, used only to install the 
SOFTWARE PRODUCT on your other computers over an internal network; 
however, you must acquire and dedicate a license for the SOFTWARE 
PRODUCT for each computer on which the SOFTWARE PRODUCT is installed 
from the storage device.  A license for the SOFTWARE PRODUCT may not be 
shared or used concurrently on different computers. 
 
Back-up Copy: You may use the back-up copy solely for archival purposes. 
 
2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS 
 
Limitations on Reverse Engineering, Decompilation and Disassembly: You may 
not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, or 
otherwise attempt to discover the source code of the SOFTWARE PRODUCT, 
except and only to the extent that such activity is expressly permitted by 
applicable law notwithstanding this limitation. 
 
Separation of Components: The SOFTWARE PRODUCT is licensed as a single 
product.  Its component parts may not be separated for use on more than one 
computer. 
 
Rental: You may not rent or lease the SOFTWARE PRODUCT, 
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SOFTWARE Transfer: You may permanently transfer all of your rights under 
this EULA, provided you retain no copies, you must transfer all of the 
SOFTWARE PRODUCT (including all component parts, the media and printed 
materials, any upgrades and this EULA) and the recipient must agree to the terms 
of this EULA.  If the SOFTWARE PRODUCT is an upgrade, any transfer must 
include all prior versions of the SOFTWARE PRODUCT. 
 
 
TERMINATION:  Without prejudice to any other rights, Irrisoft Inc. 
automatically terminates this EULA if you fail to comply with the terms and 
conditions of this EULA.  In such event, you must destroy all copies of the 
SOFTWARE PRODUCT and all of its component parts. 
 
 
3. UPGRADES 
 
If the SOFTWARE PRODUCT is an upgrade of a component of a package of 
software programs which you licensed as a single product, the SOFTWARE 
PRODUCT may be used and transferred only as part of that single product 
package and may not be separated for use on more than one computer. 
 
4. COPYRIGHT  
 
All title and copyrights in and to the SOFTWARE PRODUCT (including but not 
limited to any images, photographs, animations, video, audio, music, text and 
"applets," incorporated into the SOFTWARE PRODUCT), the accompanying 
printed materials, and any copies of the SOFTWARE PRODUCT, are owned by 
Irrisoft, Inc.  Copyright laws protect the SOFTWARE PRODUCT.  Therefore, 
you must treat the SOFTWARE PRODUCT like any other copyrighted material 
except that you may either (a) make one copy of the SOFTWARE PRODUCT 
solely for backup or archival purposes or (b) install the SOFTWARE PRODUCT 
on a single computer provided you keep the original solely for backup or archival 
purposes.  You may not copy the printed materials accompanying the 
SOFTWARE PRODUCT.  Irrisoft, Inc reserves all rights not specifically granted 
under this EULA. 
  
5.  NO WARRANTY  
 
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
IRRISOFT, INC. DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES ARE 
EXPRESSLY AND SPECIFICALLY DISCLAIMED. IRRISOFT, INC. DOES 
NOT WARRANT THAT THE SOFTWARE IS FREE FROM BUGS, VIRUSES, 
ERRORS, OR OTHER PROGRAM LIMITATIONS, INCLUDING BUT NOT 
LIMITED TO ACCURATE OR UPDATED THIRD-PARTY CONTENT.  
NEITHER IRRISOFT, INC. NOR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS 
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SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, 
OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY 
TO USE SUCH SOFTWARE EVEN IF IRRISOFT, INC. HAS BEEN ADVISED 
OF POSSIBILITY OF SUCH DAMAGES OR CLAIMS.  IN NO EVENT SHALL 
IRRISOFT’S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE 
PAID FOR LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE 
FORM OF QUALITY AND PERFORMANCE OF THE SOFTWARE.  THE 
PERSON USING THE SOFTWARE BEARS ALL RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE SOFTWARE.  
 
If any part of this Agreement is found void and unenforceable, it will not affect 
the validity of the balance of the Agreement, which shall remain valid and 
enforceable according to its terms.  You agree that the SOFTWARE PRODUCT 
will not be shipped, transferred or exported into any country or used in any 
manner prohibited by the United States Export Administration Act or any other 
export laws, restrictions or regulations.  This Agreement shall automatically 
terminate upon failure by you to comply with its terms.  This Agreement may only 
be modified in writing signed by an authorized officer of Irrisoft Inc. 
 
6. DATA BASES 
 
The SOFTWARE PRODUCT is furnished with a database of product 
information acquired from various manufacturers.  Irrisoft Inc. makes no 
guarantee to the accuracy of the furnished database.  Manufacturers prices are 
subject to change without notice.  Irrisoft Inc. accepts no responsibility for errors 
in data transfer, data entry, or translation.  The user of the database information 
is solely responsible to satisfy his or herself of the suitability of the data for use 
with the SOFTWARE PRODUCT. 
 
Distributors may furnish product databases from computer systems independent 
of Irrisoft Inc.  These databases are furnished as a convenience to the user. 
Irrisoft, Inc. makes no guarantee of the accuracy of the data.  The user of the 
database information is responsible to satisfy his or herself of the suitability of the 
data for use with the SOFTWARE PRODUCT. You agree to hold Irrisoft, Inc. 
free of all liability for any loss or damage of any sort incurred as a result of any 
such dealings with any services provided by others associated with this 
SOFTWARE PRODUCT. 
 
7. USE OF THE SOFTWARE PRODUCT 
 
The SOFTWARE PRODUCT provides tool to manage databases that can be used 
by Quik-Irr, Quik-Price, Quik-Irr and Quik-Price, products of Irrisoft, Inc.  
Quik-Irr and Quik-Irr has guides to help estimate the items required to install an 
irrigation system.  Every job site is different and the methods and materials used 
to install a project vary.  The users can override every estimate generated by the 
Quik-Irr and Quik-Irr.  Irrisoft, Inc. does not guarantee that the list of materials 
generated by using Quik-Irr, Quik-Price or Quickir will meet the job material 
requirements.  The computations used to estimate quantities are based on 
averages, ratios and mathematical formulas generally used in the irrigation 
industry.  The user has the option to adjust formula ratios used to generate the 
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estimates and also to adjust every estimated quantity.  The user must make the 
final determination as to the completeness of the material list and associated cost, 
which would be required to prepare a cost estimate and to install a project.  
 
Irrisoft, Inc. makes no guarantee to the suitability of the products used to 
assemble an irrigation system.  The user makes every choice of the components 
and assemblies, therefore accepts all responsibility for those choices. 
 
The user of this system understands these terms of this EULA and agrees to hold 
harmless Irrisoft, Inc., its owners, agents and distributors. You acknowledge that 
this Agreement is a complete statement of the agreement between you and 
Irrisoft, Inc., and that there are no other prior or contemporaneous 
understandings, promises, representations, or descriptions regarding the 
SOFTWARE PRODUCT or any related services. This Agreement does not limit 
any rights that Irrisoft, Inc. may have under trade secret, copyright, patent, 
trademark or other laws. The Representatives of Irrisoft, Inc. are not authorized 
to make modifications to this EULA, or to make any additional representations, 
commitments, or warranties binding on Irrisoft, Inc., other than in writing signed 
by an officer of Irrisoft, Inc. Accordingly, such additional statements are not 
binding on Irrisoft, Inc. and you should not rely upon such statements.  
 
8.  REGISTRATION 
 
The end user is responsible to provide Irrisoft, Inc. with product registration 
information. This information will be used to notify customers and make decisions 
about support, product and business issues. Irrisoft, Inc. will not use customer 
name or other consumer information except as permitted by applicable law. Once 
this information is received the users will be issued a password. The SOFTWARE 
will not function if the password is not installed within 60 days from the date of 
the original installation.  Registration information must be submitted to Irrisoft, 
Inc. within 30 days of the initial installation.  It is the responsibility of the user to 
see that the registration information is submitted to Irrisoft, Inc.  Irrisoft, Inc. will 
issue the password within 10 days of receipt of registration information. 
 
This EULA shall be governed by the laws of the State of Utah and shall insure to 
the benefit of Irrisoft, Inc. and any successors, administrators, heirs and assigns.  
Any action or proceeding brought by either party against the other arising out of 
or related to this EULA shall be brought only in a STATE or FEDERAL COURT 
of competent jurisdiction located in Cache County, Utah.  The parties hereby 
consent to in personam jurisdiction of said courts. 
 
 
IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA, YOU MAY NOT 
USE OR COPY THIS SOFTWARE PRODUCT, AND YOU SHOULD RETURN 
THE UNUSED PRODUCT(S) TO IRRISOFT, INC. COMPLETE WITH SALES 
RECEIPT, WITHIN TEN (10) DAYS FOR A FULL REFUND.



Table of Contents 
 
 
 

���������	
����
	� 

 

1. GETTING STARTED............................................1 

COMPUTER SYSTEM REQUIREMENTS .............................3 
SOFTWARE INSTALLATION .............................................4 
SOFTWARE REGISTRATION.............................................4 
WHERE TO BEGIN?.........................................................5 

2. BUILD THE DATABASE......................................8 

DATABASE STRUCTURE .................................................8 
PRODUCT DATA FIELDS .................................................8 
PREPARE EXPORT FILE.................................................12 
IMPORT A DATABASE ...................................................18 

3. IMPORT PRICES ................................................20 

STEPS TO IMPORT PRICE TABLES .................................21 

4. SUPPLIER INFORMATION..............................23 

5. CATEGORY NAMES..........................................24 

6. DATABASE MANAGEMENT............................27 

SEARCH THE DATABASE ..............................................27 
EDIT THE DATABASE....................................................30 
DATABASE TOOLS........................................................34 
PRICE OPTIONS ............................................................37 
SETTINGS .....................................................................40 
BACKUP AND RESTORE DATABASE..............................40 
EXPORT........................................................................41 

7. FILE BUILDER....................................................43 

CREATE LOAD FILES ....................................................43 
STEPS TO CREATE LOAD FILES ....................................44 



Table of Contents 
 
 
   
 

���������	
����
	� 

COPY LOAD FILES ....................................................... 46 
PRINT EXCHANGE  DISK LABELS .................................. 47 
QUIK-IRR SETTINGS .................................................... 47 

8. QUIK-IRR WIZARD MATCH........................... 48 

A FOUR-STEP PROCESS: ............................................... 48 

9. SEARCH TREE.................................................... 53 

TREE BUILDER............................................................. 53 
LINK PRODUCTS TO THE SEARCH TREE ....................... 56 
SEARCH TREE EDITING................................................ 58 

10. IMPORT UPDATE .......................................... 60 

11. PRODUCT INFO FILE LINK........................ 63 

BUILD A PRODUCT INFORMATION LIBRARY ................ 63 
LINK PRODUCTS TO THE LIBRARY ............................... 64 
DISTRIBUTE THE LIBRARY WITH USERS........................ 65 

12. REPORTS ......................................................... 66 

QUIK-WORD ................................................................ 68 
PURCHASE ORDER FORMS ........................................... 74 

13. ORDERS ........................................................... 83 

QUIK-ORDER ............................................................... 83 
ORDER PROCESSING .................................................... 86 

 



Getting Started 
 

 1 

���������	
����
	� 

1. Getting Started 
 
 
Irrisoft has developed a family of software products for distributors to 
provide customers with product information complete with pricing. 
Customers can search the database to generate material lists. There 
are three programs. 
 

• Quik-Price Builder - A database management tool used by 
distributors to provide a product database in a format that 
can be accessed using the other programs. 

• Quik-Price – Customers can search a product database to 
generate a material list and open linked product information 
files to provide easy access to manufacturer product data.   

• Quik-Irr – An enhanced version of Quik-Price for 
landscape irrigation estimators. It is used to quickly and 
accurately prepare material lists for sprinklers systems. 

 
The key to the Quik-Irr family of products is Quik-Price Builder, 
which is used by suppliers to provide a Load file used to exchange the 
database. 
 
        
Quik-Price Builder  
 
Quik-Price Builder is a utility program used to import a product 
database.  The database can then be used with Quik-Price and Quik-
Irr. Customers who ask for a printed price list, can be offered a price 
list on disk, complete with a program that will help them generate a 
priced material list. 
 
Once a database is imported various search tools can be added to the 
database to make it easier for customers to locate items.  Each item 
can have up to 6 product codes. Products are grouped by categories. 
The database can be searched by product code, description and 
category. A Search Tree can be built to provide yet another way to 
find items. 
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Orders can be sent from Quik-Price and Quick-Irr via email or the 
Internet and opened in Quik-Price Builder. The customer’s order can 
be exported into the company’s order management system. 
 
Product information files, such as Adobe Acrobat® files, can be 
linked to each product. Build a library of files that can be given to 
customers. The link makes it simple for uses to open the file 
containing more information on the selected product. 
 
 
Quik-Price 
 
Quik-Price is an application that is used to search the database created 
with Quik-Price Builder. A list of materials may be generated to 
estimate a project or generate a purchase order.  Items can be found 
by searching the product code, product description or by product 
category. The Search Tree helps guide users to find items. Once an 
item is located it may be added to a project material list.  This list 
may be saved, edit, printed, faxed or exported for use by other 
applications. 
 
 
 
Quik-Irr 
 
Quik-Irr has all the capabilities of Quik-Price but has additional tools 
to generate a material list for an irrigation system: 
 

• The Quik-Irr Wizard is a series of screens that prompts the 
user to select the heads, valves, controllers and other 
materials that will be needed for a project. 

• A template is a list of the most commonly used items or 
components needed for an assembly.  

• The user may work from a blank project and search the 
database to enter the materials needed for the project. 
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Earlier versions 
 
Quickir Master, Quickir and Quickir Lite are the original software 
products produced by Irrisoft, LLC.  
 
Quickir Master version 2 has been upgraded to Quik-Price Builder. 
All of the functionality found in Quickir Master exists in Quik-Price 
Builder with the exception of distributing Quickir Lite.  Quickir 
Master data files can be converted to Quik-Price Builder.  
 
To convert the files to Quik-Price Builder, go to File and select the 
Convert Version 2 database option. 
 
Quickir version 1 has been upgraded to Quik-Irr version 2. There are 
many improvements and changes to the program. Quik-Price Builder 
supports the creation of Load files for Quickir version 1. The Product 
Info file link is not supported by Quickir version 1. Quickir users are 
encouraged to upgrade to Quik-Irr. 
 
Quickir Lite version 1 has been replaced by Quik-Price. Quickir Lite 
was a free program. Use the version 1 Create Load Files option in 
Quik-Price Builder to furnish a product database for Quickir Lite 
users. 
 
Quickir Lite will no longer be supported users are encouraged to 
upgrade to Quik-Price or Quik-Irr. 
 
 

Computer System Requirements 
 
Minimum 300 Mhz - Recommend 800 Mhz or higher  
Minimum Memory - 64MB RAM – Recommend 256 MB + 
Hard disk storage - 150 MB free space – Plus Product Info Library 
Monitor – 1024 x 768 resolution 16 bit high color SVGA or higher  
8x speed CD-ROM drive or higher 
CD Writer when distributing Product Info Library 
Windows 98, ME, NT, 2000 
Printer must be supported by Windows. 
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On-line Internet access recommended for technical support, software 
and database updates. 
 
 

Software Installation 
 
1. Insert the Quik-Price Builder CD-ROM 
 
2. Most CD-ROM drives will automatically detect the disk and run 
the setup program.  If not, go to “my computer” and click on the CD-
ROM drive.  The set-up program will self execute. 
 
3.Carefully read the software license agreement. If you accept the 
conditions press OK and follow the on screen instructions. 
 
4. Run the program from the Start menu by choosing 
Programs/Irrisoft/Quik-Price Builder.  The install process allows an 
option to place a shortcut on the desktop. If there launch the program 
from this shortcut.    
 

Software Registration  
 
When the program is first launched the software registration screen 
will prompt for company information.  Fill in the registration 
information and either register on-line or print and mail the form to 
Irrisoft, Inc.; the address will be shown on the print out.  Or fax the 
form to the fax number on the form. The software authorization code 
will be sent within 7 days.   
 
To register on-line, first connect to the Internet.  When registering on-
line the authorization code will be e-mailed back within 5 days. 
 
When the authorization code is received it must be entered in the 
registration screen in the box provided. 
 
Quik-Price Builder will operate for 60 days without an authorization 
code.  After 60 days the program will not operate. 
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When moving the software to another computer or hard drive, first 
install the software, then contact Irrisoft for a new authorization code.   
 

Where to Begin? 
 
The Flow Chart is a guide, showing the steps needed to provide 
customers with a product database. 
 
 

 
 
 
There are five essential steps to create a load file: 
 

1. Import database – The supplier’s company computer 
system contains product data including: descriptions, codes 
and customer pricing.  Many systems group products by 
product type or manufacturer.  Quik-Price Builder can 
import several different database formats.  See chapter 2, 
Build the Database, for more information on export formats. 

 
2. Import Prices – Product prices are stored in separate price 

tables, one for each price group. Price data must be exported 
from the company computer to be imported by Quik-Price 
Builder. See chapter 3, Import Prices. 
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3. Supplier Information - Company name, address, and 
contact information is entered to become a part of the 
database given to customers. 

 
4. Category Names – Products are grouped by a category 

code. The code can be given a descriptive name to make it 
easier to locate items. 

 
5. Create Load Files – To provide a database to a customer, 

this utility must be run to create Load files.  In this process 
all product information is combined, together with customer 
pricing, into a single file that can be give to a customer for 
use with Quik-Price or Quik-Irr. Run the Create Load files 
utility after any changes have been made to the database and 
before distributing Load files. 

 
6. Copy Load Files – From here the “Load File” can be copied 

to a disk or another location on a computer or network. Load 
files may also be sent as an attachment to an email. 

 
 

 
Additional tools are available to make it easier for customers to 
access information: 
 

1. Wizard Match – The Quik-Irr Wizard is used to generate a 
material list for a sprinkler system.  When the Wizard 
generates a material list it searches the database for each of 
the items.  To search the database product codes are used. In 
most cases these codes are the standard product codes used 
by the manufacturers. When giving an irrigation customer a 
database, it should contain the product code used by the 
Wizard. A Wizard Match will search the imported database 
for the product codes used by the wizard. Items not found by 
the Wizard match can be found and the needed code can be 
added. 
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2. Search Tree - A Search Tree can be built to provide another 
method to search the product database. The Search Tree is 
similar to Windows Explorer with folders containing folders 
and leading to files.  Build a search tree based inventoried 
products. 

 
3. Import Update - Products are added or changed in the 

company computer system on a regular basis.  Generate 
another export file that will be used to update the database. 

 
4. Product Information File Link – Many manufacturers 

provide CD-ROMs with product data. A common file type is 
a PDF file that requires use of Adobe Acrobat Reader®. With 
permission these files can be copied to create a library of 
product information. Once a library is created, items in the 
database are linked to files in the library. Quik-Price and 
Quik-Irr users will see the link and can click to open the 
product information file. 

 
5. Orders – Quik-Price and Quik-Irr users have the tools to 

send a purchase order electronically, either by email, 
through a direct Internet connection, faxed or printed. 
Purchase orders received by Quik-Price Builder, via the 
Internet, can be opened, edited and exported to the company 
computer system for processing. 
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2. Build the Database 
 

Database Structure 
 
The database is divided into six sections: 

• Products 
• Product Prices 
• Category Names 
• Company information 
• Search Tree 
• Product Information Files 

 
The first step is to look at the database structure, the product fields 
and determine the requirements to create an export file from the 
distributor’s computer system. The next step is to import the 
products.  
 
 

Product Data Fields 
 
The database contains the following fields for each product: 

• Product ID Number  
• Descriptions (2) 
• Product Codes (6) 
• Wizard Code 
• UPC Code 
• Units Per Price 
• Units per Item 
• Unit type 
• Package Quantity 
• Size 
• Category Code 
• Sequence 
• Search Tree Link 
• Product Information File Link 
• Product Prices 
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Product ID Number 
 
Each item must have a unique product identification code (product 
ID). This can be an alphanumeric string. The product ID must be 
included as part of the import.  Most databases will have a computer 
assigned product identification code. If not, a user defined code may 
be used as long as it is unique and remains a constant.  Descriptions, 
product codes, categories and pricing can be modified, but the 
product ID must remain the same.   
 
When a database is updated the product ID is the key field that links 
the two databases to assure that product update information matches 
the correct item.  
 
Product ID is also used to create the link between the customer price 
tables and the product file. 
 
Descriptions 
 
Each item has a primary and secondary description. The product 
description is an alphanumeric field that holds up to 60 characters. 
The description can be changed to meet specific needs.  A search can 
look at character strings within the descriptions. It is easier to search 
for an item when there is consistency with names and abbreviations.  
 
Product Codes 
 
Each product must have at least one alphanumeric code product code.  
This field can contain no more than 30 characters. Up to 6 product 
codes that can be assigned to each product.  A search may be 
performed on the exact product code, the beginning characters or 
specific characters in the product code. 
 
Wizard Code 
 
The Irrigation Wizard, found in Quik-Irr, will search the database for 
a specific product code.  Where possible this code is the 
manufacturers product code.  In some cases a generic code has been 
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used. The Wizard Code is not imported. See chapter 8 - Wizard 
Match for more information. 
 
UPC 
 
A Universal Product Code may be included in this data. There are no 
search tools associated with the UPC code. It may be included in 
reports or exports 
 
Units Per Price 
 
There may be products with a price structure that may not be 
consistent with the Quik-Irr Wizard. For example wire may be priced 
per 1000 feet. If a value is entered in the units per price field, the unit 
price is adjusted by this value. For example if the wire price is $40.00 
per 1000 feet and a value of 1000 is entered in the units per price field 
then the adjusted price, exported to customers, is $.04. (Price / Units 
Per Price = Adjusted Price) 
 
Values may be imported into this field, but it will be important to 
review the items to assure that the information is correct. The units 
per item may be edited later as needed. 
 
Units Per Item 
 
There may be products that have unit quantities that may not be 
consistent with the Quik-Irr Wizard. For example a 60-foot roll of 
copper pipe may be sold as a single unit. In this case a value of 60 
could be entered in the units per price field to assure purchase 
quantities are correct. This helps prevent users from ordering 60 rolls 
of pipe when all that was needed is one 60-foot roll.  
 
The units per item value is exported and used by Quik-Price and 
Quik-Irr to alert the user to possible quantity discrepancies. 
 
Unit Type 
 
A unit of measure type is for reference only. 
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Package Quantity 
 
Package quantity is the number of items sold in a box or bag.  Quik-
Price and Quik-Irr users can use the purchase quantity to round when 
generating a purchase order. 
 
Size 
 
Item size is for reference only. In the list view items may be sorted by 
size. 
 
Category Code   
 
Products can be grouped into categories.  A category may contain 
items from a specific manufacturer, a family of products from a 
manufacturer or a group of similar products from several 
manufacturers. Each product should be assigned to a category.   
 
The category is used for two reasons: 
 

1. Searches can be narrowed to categories. 
2. Quik-Irr users can create a pricing structure for each 

category.  
 
A distributor database may contain a numeric or a cryptic code that 
defines products in a category. During the import the category code is 
also loaded into a category table. This table includes both a category 
codes and the category names. The default category name is set the 
same as the category code.  It is recommended that the category name 
be edited to provide a descriptive name, making it easier to search 
products using the category name.  See chapter 5 - Categories Names 
for more information. 
 
Sequence 
 
The sequence number determines the order the items are displayed in 
a list.  This is not a required field.  The default sort in Quik-Price and 
Quik-Irr is first by category name then by sequence. 
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Search Tree Link 
 
Building a Search Tree is a two-part process. Once a Search Tree is 
created a link must be created between the Search Tree and items in 
the database. The Search Tree Link field holds the code that creates 
that link. The path on the Search Tree is displayed as part of the code. 
See chapter 9 for more detail. 
 
 
Product Information File Link 
 
Establishing a Product Information File Link is a two-part process. A 
product information library must be created then a link is built 
between the library and items in the database. The Product 
Information File Link field displays the link file name. See chapter 11 
for more detail. 
 
Product Prices 
 
Each item has a list price and at least one customer net price. The 
database can be associated with as many customer net price tables as 
needed. Price importing is handled as a separate operation. See 
chapter 3 - Import Prices for more information. 
 
 
 
 

Prepare Export File 
 
To import a database into Quik-Price Builder an export file from the 
distributor’s computer system must be created. When preparing to 
export the database there are two things to consider: 

 
• Data fields to be included 
• Database Format 
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Data fields to be included 
 
Computer programs vary in the way data is organized and the names 
given to each field. Each system should have the same basic 
information about products. Compare the list of required data fields 
with the structure of the computer database. The following is a list of 
data fields shown with the field size and the data type: 
 
 Field Name  Size  Type 

• Product ID Number * 30  Alphanumeric 
• Descriptions * (2) 80  Alphanumeric  
• Product Code * (6) 30  Alphanumeric 
• UPC Code   16  Numeric 
• Units Per Price     Numeric 
• Units per Item     Numeric 
• Unit type   20  Alphanumeric  
• Package Quantity    Integer 
• Size    30  Alphanumeric  
• Category Code *  50  Alphanumeric  
• Sequence     Integer 

 
* Required field  (At lease one description and one Product code) 

 
 
Database Format 
 
Quik-Price Builder supports several import file formats.  Select a 
format compatible with the distributor’s system. 
 

• Paradox (*.db) 
• DBase  (*.dbf) 
• Character Separated Values (*.csv) 
• Tab Separated Values (*.txt) 
• SHIMS Product List File (*.txt) 
• ODBC – SQL Import 
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Paradox - Paradox is a database program and its format can be used 
for exchanging data. The common file extension is .db.  The field 
type must be defined during the export when using Paradox.  See the 
data field list on page 13. 

 
Dbase - dBase III is a very common format and is often available as 
an export format.  The file extension for the dBase files should be 
.dbf.  The field type must be defined during the export when using 
dBase.   See the data field list on page 13. 
 
Character Separated Values – CSV is a very common file format 
used to exchange data between applications. It is also referred to as a 
character delimited file. There are several format options used in 
CSV.  

• Field Names – Some programs will include the names of the 
data fields as the first record. There may be times when the 
first few lines may contain text that is not relevant to the 
data. There is an option to tell Quik-Price Builder if the first 
line contains filed names and which line contains the field 
names, thus ignoring the irrelevant lines.  

• Field Separator – A specific character separates each data 
field. The most common separator is a comma. Several 
export utilities allow the user to select a field separator. The 
following characters can be used:  ,  .  $  #  %  =  &  !  ~    
When importing using CSV and using a character other than 
a comma, go to Import Properties and select the field 
separator. 

• String Field Separator – A text string may have a ‘single 
quotes’  “double quotes” or no separators.  

• Trim leading and trailing spaces – The exported file may 
contain extra, unneeded spaces at either the beginning or end 
of each field. To eliminate those spaces select the trim 
option. 

 
The recommended format for a CSV export file is: 

• First line contains the field names. 
• Get structure from line one.  
• Field separator – comma , 
• String Field Separator - “double quotes” 
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A data set may look something like the following example. 
 
(Line 1) Product ID,Description,Product Code 1,Product Code 2, 
ProductCode3,ProductCode4,ProductCode5,Package,Sequence,Categ
ory, List Price 
 
(Line 2) 10501,"1802 2"," POP UP SPRAY BODY",1802R,1802,,,, 
100,100,Rain Bird Sprayheads,$2.60 
 
(Line 3) 10502,"1803 3"," POP UP SPRAYBODY", 1803R, 
1803,,,,75, 200,Rain Bird Sprayheads,$2.75 
 
Etc. 
 
 
Tab Separated Values – A tab-separated format is similar to the 
CSV format. The main difference is the field separator, instead of a 
specific character, such as a comma a TAB is used. This format is 
often more reliable than the CSV format. All the same options exist 
except the delimiter is always the TAB. 
 
 
SHIMS Product List File - SHIMS is a Unix based software 
package used in wholesale distribution. The SHIMS system accepts 
“TCL” commands to create an export that can be read by the import 
utility.   
 
To create the export file use a PC as a terminal that has a text capture 
option. 
 

1. Go into TCL and use the SELECT command to create a list 
of records that meet specified criteria. For more information 
type HELP then select in TCL. 

 
For example: to select all products with the product line smaller 
than 200 use the following command: 
 

 SELECT PRODUCT WITH LINE < 200 
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2. Once the products have been selected, type the following 
command “LIST PRODUCT ID DESC ALT1 ALT2 ALT3 
ALT4 ALT5 LINE SEQ PKG LIST REP-COST PRICE01.... 
(And other price codes as needed)   ..... HDR.SUP NOPAGE 
BY LINE      Before pressing enter turn on the screen 
capture in the terminal emulation program.  When prompted, 
enter a file name.  Once the screen capture is on go back to 
SHIMS and press enter. 

 
The result is a text file containing all of the above information.  
Each record may look something like this: 
 

 PRODUCT............. 26995*              
 ID.................. 26995               
 DESCRIPTION......... 1804 4" POP_UP BODY 
 ALT................. 1804R               
 ALT2................ RB1804              
 ALT3................ 4RPU        
 ALT4................ 1804                
 ALT5................ R1804               
 LINE................  181                
 SEQ.................    600              
 PKG.................      75             
 LIST................     2.900           
 REPLACEMENT   COST.     1.210           
 PRICE01.............   1.508             
 PRICE02.............   1.740             
 PRICE03.............   1.740             
 
 

This process may take a long time depending on the computer 
speed, connection speed and the size of the database.  
 
3. Once the file has been created, go into Quik-Price Builder 

Import and select the file type as SHIMS Product List File.  
Locate the file. Press open and the program searches for all 
the field names. The product ID may show up two times, 
once with an * and once without the *.  Use the ID without 
the *.  The file viewer displays the beginning records. To 
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display more of the records, go to Import Properties and 
choose the number of lines to be previewed. Be aware that 
the SHIMS export format has one line for each data field; 
one record could contain over 15 lines.  

 
Note: The following is an example of TCL command string that 
works: 

 
LIST PRODUCT ID DESC ALT1 ALT2 ALT3 ALT4 ALT5 LINE 
SEQ LIST REP-COST PRICE01 PRICE02 PRICE06 PRICE09 
PRICE10 PRICE11 PRICE12 PRICE15 PRICE16 PKG BY LINE 
WITH LINE LT "999" NOPAGE HDR.SUP 
 
Note: Each Shims system may be configured different.  The 
examples here work on some systems, there may need to different 
commands added depending on the system configuration. 
 
ODBC – SQL Import - ODBC is a programming interface that 
enables applications to access data in a database management system 
that uses Structured Query Language (SQL) as a data access standard.  
An SQL statement must be written to create a table containing the 
fields needed by Quik-Price Builder.  Use the SQL-92 syntax 
conventions. 
 
Every computer system has a different file structure.  The SQL 
statement will need to be written based on the file structure of that 
system.   There are several steps to the process: 
 

1. Go to Import and select the SQL type from the Import Type 
pull-down list. Open the SQL editor 

2. Select the database to be accessed. 
3. Write the SQL statement. 
4. Run the query to create the data table.  The created table can 

then be viewed.   
5. The next step is to assign the table data fields to the fields 

used by Quik-Price Builder. 
6. Then run the import. 
7. Pressing the Save Icon can save the SQL statement along 

with the field assignments.  
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Import a Database 
 
 

 
 
 
Once the export file has been created containing the required 
exported data, complete the following steps: 
 

1. Go to File and select New. Enter a name for the database.  
2. From the Flow Chart select Import or go to the Import pull-

down menu and select Import 
3. Select the file format type from the pull-down list. 
4. Locate the file containing the exported data and press open. 

There may need to be some options selected in the Import 
Properties, for more information see the detail for each 
format type. 
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5. The file is displayed in a column format, if each field is not 
clearly displayed, changes may need to be made to the 
Import Properties or there may be problems with the export 
file. 

6. Now associate the data column with the fields needed by 
Quik-Price Builder. Use the pull down list by each data field 
to select the name of the field that corresponds to each field. 

7. Press OK.  Quik-Price Builder will begin importing the data.  
8. Then SAVE the import script to file. All the choices made 

are saved in a file. Press the Save icon and name the import 
script. This script can be opened later to refresh all the 
options when prices are imported or when running an import 
update. 

 
 
Once a database has been imported there are several more steps to 
complete:  
 

• Prices need to be imported. 
• Enter the Supplier Information. 
• Category names need to be defined.  
• Review and edit the database as needed. 
• For databases going to Quik-Irr users, the Wizard Match 

needs to be completed. 
• Build a Search Tree and create the links. 
• Assemble a Product Information Library and create the 

links. 
• Create a Load file to distribute the database with Quik-Price 

and Quik-Irr users. 
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3. Import Prices 
 
 
The process to import prices is very similar to importing the product 
data. The same initial steps are required: 

 
• Identify the data fields to be included. 
• Determine the database format. 

 

 
 
 
For each product Quik-Price Builder has a “List” price and a 
customer net price. When a Load file is created both the list price and 
one customer net price is included. There is only one “List” price 
table but there can be an unlimited number of customer net price 
tables.  



Import Prices 
 

 21 

���������	
����
	� 

 
Each price table is a separate file. When creating a load file, to be 
distributed to Quik-Price and Quik-Irr users, the product data is 
automatically merged with the list price and one of the net price 
tables.  When running the create Load files process the price tables to 
be included are selected. 
 
 

Steps to Import Price Tables 
 

1. Create an export file from the company computer system 
containing the product ID and at least one price list. The 
format should be the same used for the product import. The 
export file can be the same file that contains the product 
information. 

2. Select Import Prices from the Flow Chart or from the Import 
pull-down menu. 

3. Identify and select the file type in the Import Type pull-
down list. 

4. Enter the file name or locate the file using the browser. 
5. Once the file is opened the contents are displayed. If the file 

contents are not displayed properly select Import Properties. 
(Refer to chapter 2 for more information on options relative 
to each file type.) If, after changing the properties the data is 
not displayed properly the problem may be with the export 
file and another file type may need to be used. 

6. Once the data is displayed and the fields can be identified 
assign the fields. The Product ID assignment must be made. 
The product ID in price table must match the product ID in 
the product database. Use the pull-down list to display the 
fields and select the product ID. 

7. List price is typically the manufacturers suggested list price 
or a base price. This price is included with each database 
given to customers. From the List Price Field pull-down list, 
select the list price field. This is not a required field. If price 
tables are imported several times, this price table does not 
need to be imported each time. It is only needed when prices 
change. 
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8. The Price Fields box displays all fields, using the mouse 
click the Import box to select the price field (or fields) to be 
imported.  

9. Each price file is given a file name. The default file name is 
the name of the field. The name may be changed by entering 
a new name. 

10. Press Run Import when ready. 
11. These settings can be saved by pressing the Save icon and 

then entering the name of Import Script. With the Import 
Script saved, next time prices need to be imported open the 
import script and all settings made will be restored. 

 
For more information about price options see chapter 6. 
 

• Units per price 
• Products without a price report 
• Changing the list price table 
• Selecting a price table 
• Viewing and editing a price table 
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4. Supplier Information 
 
 
The Supplier Information data can be accessed from either the Flow 
Chart or from the View pull-down menu. 
 

 
 
Fill in the company name, address, phone numbers etc. Information 
entered in the Supplier Information screen is exported with the 
databases.  This company information is displayed on the opening 
screens of Quik-Price and Quik-Irr. Users can also access this 
information within the program. Supplier information is included on 
purchasing reports.   
 
Enter the primary supplier location. Branches may be added by 
pressing the add button (+).  
 
Pressing the Contacts button to Information regarding key contacts at 
each branch location.  
 
The Supplier Information screen also has the location for Internet 
Order Settings. See chapter 13 for more information. 
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5. Category Names 
 
 
The category code may be an alpha/numeric code used to group 
similar products.  When products are imported a category code should 
be included. During the import a category table is created.  Each 
category code is given a name. The default name is set the same as 
the category code. After importing the data go to the category names 
screen and edit the category name.  Often the category code is cryptic 
and not helpful to those unfamiliar with the code. A logical name 
makes it much easier to search the database.  
 
 

 
 
To rename the category put the cursor in the category name field to 
be changed and type over the exiting name. 
 
From the Category Name window there are several other tools. 
 

• Move through the list  
• Sort the list 
• Add a category 
• Run a Category Search 
• Locate Items without a category 
• Delete all items by category 
• Print the list of categories 
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Move through the list  
 
There are several buttons to help navigate the list. Use these buttons 
to move the First, Last, Prior or Next record in the list.  The slide bar 
may also be used to scroll through the list. 
 
Sort the list 
 
There are two columns in the Category name window. Click on the 
heading of the column to sort by that column. When renaming 
categories it is much easier to sort on the Category Code column. 
 
 
Add a category 
 
When new items are imported into the database the category code is 
automatically added to the category table. If additional categories are 
needed press the add (+) button. Enter the new category code and 
name. Products can be reassigned to the new category in the Form 
View window by selecting the category name from the pull-down list.   
 
Run a Category Search 
 
When the List View Window is open, press the Run Category Search 
to display the records in the selected category. Select a different 
category and the list view will be refreshed, displaying the items in 
the newly selected category. 
 
Locate items without a category 
 
There may be some records that do not have a category code. To 
display those records press the “Show Products without a Category” 
button.  
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Delete all items by category 
 
The delete button will delete both the category AND all products with 
that category code. This cannot be undone! Be careful, it can be a 
very useful tool to delete undesired records, but if not understood 
could remove records that should not be.  
 
Print the list of categories 
 
Pressing the Print icon will print the list of category names. A print 
preview window displays the report before printing. From this screen 
the printout can be: 

1. Send to printer. 
2. Print setup options may be selected. 
3. Other pages may be previewed. 
4. The Zoom in / Zoom out icons control the size of the 

preview. 
5. The printout may be edited in Quik-Word.  See chapter 12 – 

Reports for more detail. 
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6. Database Management 
 
 
 

Search the Database 
 
There are many ways to search the database to quickly find a product.  
Most searches are executed from the Search Tool bar located toward 
the top of the screen. 
 
 

 
 

• Product ID 
• Exact Product Code  
• Product Code Beginning Characters 
• Partial Product Code 
• Description Search  
• Category Search 
• Combined Search 
• Search Tree 

 
Product ID  
 
If the product ID is known, enter the code in the exact search box and 
press enter or the ID button.  The product will then be displayed. 
 
Exact Product Code 
 
If the exact product code is known, enter the code in the exact search 
box and press enter or the PC button.  The product will then be 
displayed. If there are items with the same product code, a list 
showing the items will be displayed, select the desired record. 
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Product Code Beginning Characters 
 
Often the initial characters of a product code are known and represent 
a number of items. Enter at least two characters and press the PC? 
Button. Select the desired item from the list of items that match the 
beginning characters. 
 
Partial Product Code  
 
To search using key characters found in the product code use the 
search boxes to enter a string of characters that would be found in the 
product code. Press the Product Code button. All items matching the 
character string entered will be found. 
 
Description Search 
 
To search using the product descriptions, use the search boxes to 
enter a string of characters that would be found in the description. 
Press the Description button. All items matching the character string 
entered will be found.  
  
Category Search 
 
Products are grouped by category. There are two ways to look for 
items by category. 
 

1. In the Edit Mode the Categories and List View windows are 
open. Press the Run Category Search button. Select a 
category from the list. All items in the selected category are 
displayed in the List View window. 

2. In the Search Tool bar there is a category pull-down list. The 
category name is displayed in the list. Once a category is 
selected only those items found in that category will be 
displayed in the list view. When selecting a category from 
the list the first letter of a category name may be typed to 
jump to that category. 
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Combined Search 
 
A combined search uses both a category and either a product code or 
description search. To use the combined search, enter character 
strings of the product code or description in the search boxes. Then 
select a category from the pull-down list. Press either the Description 
or Product Code search button. This will narrow a search to a specific 
category. This method is often the fastest way to search the database.  
 
Search Tree  
 

 
 
Once the Search Tree has been built and products assigned, the 
Search Tree can be used to locate items. Press the Search Tree icon 
and select Run Tree. 
 
Search Tool Bar 
 
The Search Tool bar contains two additional buttons that will be used 
on a regular basis. 
 
 
Clear Search Text – Press Clear Search Text button to erase entries 
in the search boxes. 
 
NOTE: All searches filter out records that do not meet the search 
criteria. The number of active records is displayed at the bottom of 
the screen. Clearing the Search boxes does NOT reset the filters.  
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ALL – Pressing the ALL button eliminates all filters. All the records 
are then displayed. 
 
 

Edit the Database 
 
Once a database has been imported it good to review the results. The 
best way to review and edit the database is in the Edit Mode. The Edit 
mode can be opened any of threes ways: 
 

1. Flow Chart 
2. Edit Mode Button 
3. View pull-down list 

 
The Edit Mode opens three windows that can be viewed 
independently but in this mode these three widows can help to 
navigate, view and edit the database.  
 
 

 



Database Management 
 

 31 

���������	
����
	� 

1. The Categories window displays the list of categories by 
name and code. Using the Run Category Search can be used 
to quickly review products by category. 

2. The List View window displays the database in a columnar 
format.  

3. The Form View window displays all data associated with 
each record. Editing the data should be done in the Form 
View. When an item is selected in the List View the 
information for that product is immediately displayed in the 
form view. 

 
List View 
 

 
 
The List View displays the data in a columnar format. There are two 
lines of data for each record. The columns are divided into major 
groups referred to as bands. The bands and their default contents 
include: 

1. Description 
a. ID Number 
b. Product Code 1 
c. Description 
d. Secondary Description 

2. Links 
a. Product Info File Link 
b. Tree Position 

3. Group 
a. Category Code 
b. Category Name 
c. Sequence 
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4. Product codes 
a. Product Code 2-6 
b. Wizard Code (Needed for Quik-Irr users only) 

5. General 
a. Package Quantity 
b. Unit of Measure 
c. Unit 
d. UPC 
e. Date Updated 

6. Pricing 
a. List Price 
b. Current selected net price  

 
These bands and columns may be moved, resized and sorted as 
needed.  

• Move – A column or band may be moved by clicking on the 
name in the header, holding the left mouse button while 
dragging the column to the new location. 

• Resize – To resize a column, position the cursor in the 
header and on the line that divides a column or band. When 
the cursor changes to opposing arrows, click and hold the 
left mouse button while dragging the line to a new width. 

• Sort by Column – records may be sorted by column. To 
sort, click on the column header. A sort symbol is displayed 
in the column indicating the column has been sorted. Sorting 
always occurs in an ascending order.  

 
 
Selecting records – A record selected in the List View is displayed in 
the Form View Window. Editing can be done in the Form View 
window. 
 
More than one record may be selected at a time for deleting or when 
creating links to those records. To select a range of records, click on 
the first record in the range, then press and hold the SHIFT key, then 
using the mouse select the last item in the range by clicking on that 
item. The range is highlighted and all items are selected for action. 
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To randomly select multiple records press and hold the CTRL key, 
using the left mouse button click on the desired records. The selected 
items are highlighted and are ready for edit. 
 
To unselect the items, release the shift or CTRL key and click on an 
item outside of the highlighted group. 
 
 
Form View 
 
All fields associated with an item can be viewed in the Form View 
window. Each of the fields may be edited, however there are some 
things to consider when making changes.  
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Editing Fields - After making a change press the enter key to record 
the change and update the record. 
 
Product ID – Care should be taken when editing this field. The price 
tables use this field to establish a link between the product database 
and the price tables. This field is also used to form a link when 
updating the database. 
 
Updated – This field is automatically updated by the import and 
update process. 
 
Wizard Code – Quickir and Quik-Irr users need this code for the 
irrigation Wizard to work properly. Non-irrigation suppliers should 
ignore this field. This field is best edited using the Wizard Match 
utility. See chapter 8 for more detail. 
 
Price Options – See Price Options later in this chapter for more 
detail. 
 
Categories – The best way to change a category assignment is to use 
the pull-down list at the Category Name. 
 
Links – To edit the link fields, see the chapter 9 on the Search Tree 
and Product Info File Link. If an item has been linked to a Product 
Info File clicking on the Product Info File button can open that file. 
 

Database Tools 
 
There are several tools that should be run to check the database for 
possible problems. 
 
Duplicate Product Codes Report 
 
There are two concerns about duplicate product codes. 
 

1. Duplicates could confuse the end users. 
2. Quickir Version 1.7 and earlier does not support duplicate 

product codes. 
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From the Tools pull-down menu, select Duplicate Product Codes 
Report. Run the report by pressing the Run button.  
 

 
 
There are two types of duplicate product codes. 
 

1. The same code used for the same item. For example product 
code 1 and product 2 might be exactly the same for the same 
item. This does not pose a problem to any version of 
Quickir, Quik-Irr or Quik-Price; it may be a nuisance so 
duplicates could be edited out. 

 
Once the report is completed, if there are duplicate product 
codes for the same item, those duplicates pointing to the 
same item can be deleted from the list. Press the Remove 
Duplicates from Display button. This does NOT remove the 
duplicates from the database but only from the report. 
 

2. If the same product code exists for separate items, it could 
create confusion for users. If duplicate product codes are 
found in Quik-Price or Quik-Irr a list of duplicates is 
displayed and the user must choose from the list.  

 
WARNING: Quickir version 1.7 and earlier users will not 
see the duplicates. If duplicates exist the first record found 
will be displayed.  It is important to eliminate duplicate 
product codes for these users. 
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After the report is run, review the list. The Find Product 1 and 2 
buttons bring up the records containing the duplicate items. Edit the 
database as needed. The report may need to be re-run after the editing 
is complete. 
 
Duplicate ID Number Report 
 
It is vital that there not be duplicate ID numbers. Price tables are 
linked to the product database. If duplicate ID numbers exist price 
data could be wrong. Run the duplicate ID number report from the 
Tools pull-down menu. Company computer system ID should not be 
generating duplicate ID numbers, but it is important to verify. If 
duplicate ID numbers are found identify the cause and correct the 
problem and edit the database as needed.  
 
The Duplicate ID report displays the ID number and duplicate 
product one and two. If additional duplicates are found they will be 
listed consecutively. Review the list, use the Find Product 1 or 2 
buttons to open the record and either delete or edit as needed. After 
the editing the database, re-run the duplicate report. 
 
 
Delete Products without a Category 
 
Some databases have items that do not have a category and need to be 
deleted. From the Tools pull-down menu select to Delete Products 
without a Category.  Before running this utility, it may be wise to 
review the items that would be deleted by this action. In the Edit 
Mode there is an option on the Categories window to Show Products 
without a Category.  
 
 
Delete Products without a Product ID 
 
There are times when items are imported that do not have an ID 
number. No price data can be linked to these items. To delete these 
items run the Delete Products without a Product ID from the Tools 
pull-down menu.  
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To identify these potential records before running this delete utility 
those items can be found by opening the List View. Press the ALL 
button to display all records. Click on the ID number column to sort 
on the column. Items without an ID number will be displayed first. 
Review this list before running the delete. It may be there is an error 
with the ID number on some records. 
 
Import Product Info Links 
 
The Quik-Price Builder CD comes with product information files that 
have been provided by several of the irrigation manufacturers. These 
files can form the beginning for your own library. Links to this 
database can automatically be added to the database. This utility will 
only link items that have been found using the Wizard Match. Not all 
items will have a link.  
 
The Wizard Match must be completed for this to work. This utility 
will overwrite existing links. This utility is provided as a convenience 
and a beginning of a product information library. Not all the 
manufacturers have contributed to the library. Add to the library and 
create links items in the database. 
 
Pack Database 
 
After deleting many items from the database it may become 
necessary to Pack the Database. This is a utility to cleanup the 
database internally. 
 

Price Options 
 
There are several options associated with product prices. In many 
cases these options will not be needed, but have been provided to 
meet specific situations. 
 
Selecting a Price Table 
 
Quik-Price Builder supports as many price tables as needed. Only one 
net price table is viewed at a time. To select a price table go to the 
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Form View window. In the Price Info box both the list price and a net 
price are shown. Click on the button under the price field to open a 
list to select a price table. It is this selected price that is shown in the 
List View window. 
 
Changing the List Price Table 
 
The list price table is assigned when the list price is imported. There 
are two ways to change the list price table. 
 

1. From the Settings pull-down menu select List Price Table. 
Select the new list price table from the displayed list.  

Or 
2. In the Form View window the Price Info box shows both the 

list price and a net price. Click on the button under the list 
price field to open a list, and then select the price table. The 
selected list price is shown in the List View window. 

 
 
Viewing and Editing a Price Table 
 
To view the price table, click on the $ button next to the price fields 
in the Form View window. This will open a window displaying a 
table containing the Product ID and the price. This table may be 
edited as needed. When the table is opened the entire contents of the 
table can be viewed but when the window is opened the top item is 
the current item being viewed in the Form View. 
 
If the current product does not have a price, open the price table and 
edit the price. Remember only one table is being edited, if a price is 
missing for an item and a price needs to be added, the other price 
tables may need to be opened and edited.  
 
 
Units Per Price 
 
The imported price of an item may create a conflict when using the 
Quik-Irr Wizard. If this is the case the unit price can automatically be 
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adjusted by entering the number of Units per Price. When a value is 
entered an adjusted price is displayed. The adjusted price is the value 
included in the Load file.  
 
For example wire may be priced per 1000 feet. If a value is entered in 
the Units Per Price field, the unit price is adjusted by this value. For 
example if the wire price is $40.00 per 1000 feet and a value of 1000 
is entered in the units per price field then the adjusted price exported 
to customers is $.04. (Price / Units Per Price = Adjusted Price) 
 
Values may be imported into this field, but it will be important to 
review the items to assure that the information is correct. The units 
per item may be edited as needed. 
 
There may be times when both the Units Per Price and the Units Per 
Item must be used. Taking the above example the roll size may be 
250'. A value of 250 would need to be entered in the Units Per Item 
field.   
 
 
Units Per Item 
 
When a value is entered in the Units Per Price field, this same value 
automatically is entered in the Units Per Item field. Some customers 
may not know how many units are included when purchasing an item.  
The description may indicate a 10’ 2”x4” piece of wood. In this case 
there would be10 units of 10 feet per item.  
 
If the “units per item” is not the same as the units per price, enter the 
correct number of units in the Units Per Item Override field.  
 
There may be products that have unit quantities that may not be 
consistent with the Quik-Irr Wizard. For example a 60-foot roll of 
copper pipe may be sold as a single unit. In this case a value of 60 
could be entered in the units per price field to assure purchase 
quantities are correct. This should prevent users from ordering 60 
rolls of pipe when all that was needed is one 60-foot roll.  
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The units per item value is exported and used by Quik-Price and 
Quik-Irr to alert the user to possible quantity discrepancies. 
 
Unit Type 
 
A unit of measure type is for reference only. 
 
Show Products without a Price  
 
In reviewing the database before distributing it to users it is important 
to check the database for correct pricing and possible blank or zero 
price items. Go to Show Products without a Price from the Tools pull-
down menu. Selected records are filtered to display only those 
products without a price. It is often easiest to view in the List View 
window.    
 
Note: This is NOT searching all price tables it is only searching the 
current selected net price table. 
 

Settings 
 
Folder Locations 
 
There are two folders that can be assigned. All other folders should be 
left in the default location set when the program was installed. 
 

1. The location of the Product Information Files 
2. Backup file location. 

 
From the Settings pull-down list open the folder locations window to 
view and edit the folder assignments. 
 

Backup and Restore Database 
 
Periodically make a backup of the database files. A backup should 
also be done before making major changes to the database. 
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Create Backup 
 
To create a backup file, follow these steps: 
 

1. Go to the File pull-down menu and select Create Backup. 
2. Enter the file name for the backup file and press Save. 
3. The option is then given to include the price tables. If there 

are many price tables this can become a very large backup 
file.  

  
Restore 
 
To restore a backup Quik-Price Builder must first be installed on the 
computer. 
 

1. Go to the File pull-down menu and select Restore Backup 
2. Locate the file that contains the backup and press open. 
3. The entire contents of the backup file are restored. Any 

existing files with the same names will be overwritten. 
 
A backup is a single file that can also be used to transfer the database 
to another computer. 
 

Export 
 
The entire database or selected items may be exported for use with 
other applications. There is an Export button in the List View 
window. Enter a file name and select the file type. There are three 
options available: 

• Microsoft® Excel 
• Comma Separated Values 
• HTML 

 
Microsoft® Excel spreadsheet format - Once the file has been saved 
it may be opened in Excel.  There are times when it may be desirable 
to export to Excel to make changes to the database and then run an 
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import update. The edited file exported from Excel should be saved 
as a Tab delimited text file. 
 
Comma Separated Values – CSV is a very common format that can 
be opened by many applications. 
 
HTML – web based file structure. 
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7. File Builder 
 
 
The File Builder has the tools to provide Quik-Price and Quik-Irr 
users with a product database. There are several tools that are part of 
this process. 
 

• Create Load Files 
• Copy Load Files 
• Exchange Quik-Irr settings  
• Print disk labels 

 
 

Create Load Files 
 
Once a database is ready to be given to Quik-Price and Quik-Irr users, 
a utility must be run to prepare and compress the data files to create a 
Load File. A Load file is a single and contains the following data: 
 

• Product Descriptions 
• Product Codes 
• Units and general product data 
• Categories and Category Names 
• The Search Tree 
• Supplier Information 
• Product Information File Links 
• A one net price and a list price for each item 

 
 
 
NOTE: The Product Information Library files are NOT included in 
the Load File. The library should be copied to a CD and distributed 
separately. 
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Before creating load files check to see that the following work has 
been completed: 
 

�� Product database imported 
�� Prices imported 
�� Supplier information entered 
�� Purchase order settings 
�� Category names assigned 
�� Search Tree (not required but encouraged) 
�� Wizard Match (required for Quik-Irr users) 
�� Product Info File Links assigned 
�� Check for duplicate codes 
�� Price check 

 
 

Steps to Create Load Files 
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When Load files are created they are place in the load files folder. 
The typical path is c:\Program Files \ Quik Price Builder \ Load Files. 
The file extension for a load file is *.qz2. (Quickir version 1 load files 
have a *.qzp extension). The size of the file will vary depending on 
the number of products. It takes approximately 50-60KB per 1000 
items. 
 
There are three ways to open the Create Load Files screen. 

1. The Flow Chart 
2. Create Load Files button 
3. From the Disk Builder pull-down list 

 
Open the Create Load Files screen. Notice the current selected List 
Price table is shown on the right for reference. This price table will be 
included in the process and will be displayed as the list price in Quik-
Price and Quik-Irr. There are several options to be set. Review the 
options before running the Create Load files utility: 
 

• Load files settings 
• Date of price update 
• List of files to create 

 
Load files settings  
 
The load files settings include three options. Check the box if to 
include the option. 
 
Create Quickir version 1 files – Quik-Price and Quik-Irr load files 
are automatically prepared. If version 1 load files are also needed 
check the box. Version 1 load files have the file extension *.qzp. 
These files are saved in the same folder. 
 
Include Search Tree – If the Search Tree is not complete or is not to 
be included with the database, uncheck this option. 
 
Enable Direct Orders – Orders may be sent electronically via the 
Internet by mail or through a direct Internet connection using TCP/IP. 
If direct order support has not been setup disable this option. For 
more information, go to chapter 13.  



File Builder 
 

 46 
 

���������	
����
	� 

Date of price update 
 
Today’s date is the default date; it can be changed from the pull-down 
calendar. This date is included as part of the database and is shown on 
the opening screen of Quik-Price and Quik-Irr to inform the user 
when the prices were last updated. 
 
Select Price Files 
 
Select the price fields to be used in creating a Load file by checking 
the box next to the file name. There are two buttons that help to either 
un-check or check all price tables. The default Load file name is the 
same as the price table name. The name for the file may be changed. 
Enter the new file name as needed. 
 
Run Create Load Files 
 
Press the Create Load Files button. This utility will take several 
minutes. Upon completion the files can be given to Quik-Price and 
Quik-Irr users. 
 
NOTE: Remember each time changes are made to the database this 
utility needs to be run before distributing the files to customers. 
 

Copy Load Files 
 
To distribute a Load file go to the File Builder and select Copy Load 
Files.  This option is also available on the Flow Chart.  
 

1. Once the screen is open select either the format either 
a. Version 1 is for all Quickir Users 1.7 or earlier and 

Quickir Lite users. 
b. Version 2 is for Quik-Price and Quik-Irr users. 

2. Select the copy location, insert a blank disk if needed and 
press the copy button.  

 
A data disk can be used with only Irrisoft products.  The contractor 
must first install an Irrisoft program and then Load the data disk.   
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NOTE:  The Create Load file utility must be run prior to distributing 
the files. 
 

Print disk labels 
 
Labels for the data disks can be printed. The data disk label includes 
the supplier name as entered in the supplier setup screen.  The sheets 
are formatted for use with the Avery 5196 or equivalent.   
 

Exchange Quik-Irr Settings   
 
Quik-Irr has many customizable settings that make it easier to use. 
Often these setting have regional similarity. These settings in include: 
 

• Custom Wizards 
• Templates 
• System Preferences 

 
A supplier can customize Quik-Irr to meet the needs of the market. 
These settings can be retrieved by Quik-Price Builder to be shared 
with other Quik-Irr users. This is a four-step process: 
 

1. The PC that is running Quik-Price Builder must also have 
Quik-Irr. Use this same computer to build the Templates and 
Wizards and also set system preferences. 

2. Run the Build Quik-Irr Settings File found in the File 
Builder pull-down menu. A settings file must be given then 
press save. All the settings are saved in the file. 

3. When the file has been created it can be distributed to Quik-
Irr users. Use the Copy Quik-Irr Settings File command to 
open the copy screen. The saved settings files are listed and 
can be copied to the desired location 

4. There is utility in Quik-Irr that is used to import these 
settings. 

 
Refer to the Quik-Irr help files for more information on customizing 
and importing the preferences.  
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8. Quik-Irr Wizard Match 
 
 
The Quik-Irr Wizard uses product codes to search the database when 
building a material list for a project.  A Wizard Code is used to 
correctly link products in the database with products that can be 
selected when using the Wizard. Quik-Irr users will need to have a 
database that contains the Wizard codes. The Wizard Match process 
searches the database for all possible codes and provides the tools to 
find the products to properly set the Wizard Code.  
 
Whenever possible the Wizard Code is the manufacturer’s part 
number as listed in published price lists. For some generic items the 
Wizard Code has selected by Irrisoft.  
 

 
 
 

A four-step process: 
 

1. Run the Wizard Match 
2. Review “Probable Matches”  
3. Skip non-stock items 
4. Find and match all “un-matched items 
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1. Run the Wizard Match 
 
Open the Wizard Match Mode from the Flow chart or from the View 
Pull-down menu. Press the Run button to start the Wizard Match. The 
database will be searched for possible matches. This automatic 
follows three phases. Each phase is attempting locate a match for 
each item. The result will be two lists, a matched and an un-matched 
list.  The text color for each items displayed in the matched list 
indicates which phase found the match. 
 
The phase I search is searching for the Wizard Code in the Wizard 
Code field. The first time the Wizard Match is run there will be no 
match in this phase. The text color for items found in the phase one 
search is black. When the Wizard Match is run a second time all 
items will be displayed in black. This color-coding will only be of 
value the on the first run. 
 
Phase II of the search looks for the Wizard code in all other product 
code fields. The text color for items found in this phase is blue. Items 
found in this phase have a high probability of being correct matches. 
 
Phase III of the search uses other possible codes to search. Some of 
the part numbers may contain dashes or other less significant 
characters. Product codes in the database may use these codes. The 
text for these items is dark red. The probability of a match is not as 
high but still very probable.   
 
When an item is manually matched the text is displayed in green. 
 
The color code can be of value to determine the probability of a 
correct match.  
 
2. Review “Probable” Matches 
 
Review the list of items that are "Probable" matches to make sure the 
correct item is found. When an item is selected in the Probable list on 
the left, the corresponding item found in the database is highlighted in 
the List View on the right.  
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Once the match is confirmed, set it as a "Matched" item by 
pressing the Matched button. 
 
If the item is linked to the wrong item the Wizard Code needs to be 
deleted from the list and the correct item should be found. Use the un-
match button to move the item from the probable list to the un-
matched list. The corresponding Wizard code is also cleared from the 
incorrect item in the product database. 
 
3. Skip non-stock items 
 
There will be items used in the Wizard that are not included in the 
database. The next step is to review the Un-matched list and 
determine if the items would be found in the database. Those items 
can be moved to the Skipped list by pressing the Skip button. 
 
4. Find and match all “Un-matched” items 
 
The next step is to locate the remaining un-matched products in the 
database. There are three ways to go about locating items: 

• If the product code is known, enter it in the code to locate 
the item. 

• When an item is selected a set of possible search codes is 
automatically put in the search tool bar.  Narrow the search 
by selecting the category the item is in. Press the search by 
Product Code or by Description button to find possible 
matches.  

• Enter a different set of search criteria to locate the item. 
 
Once the product is found press the Match Icon. The Wizard code is 
entered and the item is moved from the un-matched list to the 
matched list.   
 
 
Wizard Match Window Tools 
 
There are several tools in the Wizard Match Window that need to be 
understood. 
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Run – This initiates the Wizard Match Search 
 
Match – Once a Probable match or Un-Matched item is found, use 
this button to set the Wizard Code to the item. When the code is set 
the item moves from the Probable or Un-Matched list to the Matched 
list. 
 
Skip – Press the Shipped button if the item is not a part of the 
database it will be sent to the Skipped list.  
 
Delete – Items can be cleared from the skipped list by pressing the 
delete button. 
 
Print – The selected list can be printed for review. 
 
Close – This will close the Wizard Match window. 
 
Un-Matched – Those items not matched after running the Wizard 
Match are listed in here. 
 
Probable – When the Wizard Match is run items automatically found 
are put in this list. Items need to be verified and set as Matched items 
using the Match button. 
 
Matched – Those items matched after running the Wizard Match are 
listed in here. 
 
Skipped – Those items moved to a Skipped list are shown here. 
 
Columns – The columns may be moved, resized and sorted. 
 

• Move – A column may be moved by clicking on the name in 
the header, holding the left mouse button while dragging the 
column to the new location. 

• Resize – To resize a column, position the cursor in the 
header and on the line that divides a column or band. When 
the cursor changes to opposing arrows. Click and hold the 
left mouse button while dragging the line to a new width. 
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• Sort by Column – records may be sorted by column. To 
sort click, on the column header. A sort symbol is displayed 
in the column indicating the column has been sorted. Sorting 
always occurs in an ascending order. 

 
To reset the list to the default sequence, press the Sequence column 
header. 
 
Filter - Items in the Wizard database have been grouped by Category. 
Select a Category from the Filter pull-down list to narrow the view of 
items listed in the Matched, Probable, Un-matched or Skipped tabs. 
Choose (ALL) to display the complete list of items.  
 
Find -To find a specific item in the Wizard database enter characters 
that would be found in either the Description or the Product code. 
Press the Find button. To locate the next item with the selected 
characters press the Find Next button.  
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9. Search Tree 
 
 
A Search Tree can be built to provide another method to search the 
product database. The Search Tree is similar to Windows Explorer 
that uses folders containing folders that lead to files. Build a Search 
Tree based on the products in the database.  The tree structure 
consists of a root, or beginning point for the search.  From each root 
are branches.  Products in the database are linked to branches on the 
tree. 
 
There are two steps to setting up a Search Tree: 
 

• Building the Search Tree 
• Link products to the Search Tree 

 

Tree Builder 
 
Quik-Price Builder has tools to build and edit the Search Tree. Start 
by opening the search tree.  This can be done from the Flow Chart or 
the Search Tree icon or from the View pull down menu. The Search 
Tree is displayed on the left and the List View of the database is 
displayed on the right. 
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To Begin press the Tree Builder button, this displays the Search Tree 
work area. There are tools to build and control the tree: 
 
New Root (Ctrl-R) - A root is the starting point for branches to be 
built. Pressing this icon adds a "root" to the tree.  Type the name for 
the root point and press enter.  Add as many roots as needed, but they 
should be kept to a minimum. It is faster to view a short list of 
choices rather than a long list.   
 
New Sub Branch (Ctrl-S) - A sub branch comes off a root or a 
branch, it is the step further into the tree.  Position the cursor on the 
root or branch that an additional branch should be added.  Press the 
New Sub Branch icon.  A branch is added at the bottom of the list.  
Type the name of the branch and press enter.  
 
+ / - Symbols - When branches are added to a root or other branches 
a - sign appears by the existing position.  Pressing the minus sign 
hides the added branches.  The - sign then changes to a + sign, 
indicating there are additional branches located under a branch.  
Pressing the + sign expands the tree to show the next level of 
branches.   
 
The Search Tree can extend out 15 branches deep; it is easier for 
customers to look at a short list that opens as a branch is selected, 
rather than at long lists. 
 
New Branch (Ctrl-B) - This will add an additional branch under the 
same branch or root.  It is not necessary to reposition the cursor; the 
New Branch will be added under the current branch.  Type the name 
of the branch and press enter 
 
Delete branch  - To delete a branch or root, first use the mouse to 
highlight the position to be deleted, and then press the delete icon.  
All branches under the deleted branch or root will be deleted.  Also, if 
any product has been assigned to the branch, the link will also be 
deleted. 
 
Expand All Branches – To view the entire tree, press the Expand All 
Branches icon. 
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Collapse All Branches - To reduce the tree to display only the Root 
nodes of the Search Tree, press the collapse all button. 
 
Sort – Branches and roots are added to the Search Tree in the order 
they are entered. Press the sort button to order the items in an 
alphanumeric sequence. 
 
Save Tree – When working on the Search Tree press the Save button 
to write changes to the disk. When exiting the Search Tree Builder 
the work is saved. 
 
Close - When finished, close the Search Tree using this icon. 
 
Print - Print the Search Tree to review and allow others to review the 
structure before assigning products to the tree. 
 
Print Selected Branches including products – This print option can 
be used to create a list grouping items as they are in the Search Tree, 
Search Tree headings are also included in the report. 
 
Renaming roots and branches - Two left mouse clicks over the text 
changes the text to an edit mode. The rename option can also be 
executed with a right mouse click. 
 
Import Sample Tree – Irrisoft has created a Search Tree as part of 
the Sample database. This Search Tree can be imported as a 
beginning point. It is recommended that the Wizard Match be 
completed first. When the Sample Search Tree is imported items 
found in the Wizard Match will automatically be linked to the 
imported Search Tree. 
 
The Search Tree must be empty for this option to work. 
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Link Products to the Search Tree 
 
 
Once the Search Tree structure is complete products can be linked to 
the tree. Products can only be linked to the furthest branch on the tree. 
An item can be assigned to only one position on the tree. Linking 
items is a two-step process: 
 

• Locate the item in the List View 
• Use the link tools to create the link 

 

 
 
 
Locate the item in the List View 
 
Use the available search tools to locate the items to be linked to the 
Search Tree. The items must be displayed in the List View. 
 
Use the link tools to create the link 
 
There are several ways to create the link between the Search Tree and 
items in the database. 
 

• Drag and Drop 
• Link to Tree button 
• Right Mouse 
• Function key F-12  
• Link All to Tree button 
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Drag and Drop – Once products are found, select either individual 
items or multiple items.  
 

Select a single item by clicking on the item; the selected 
record is then highlighted. 
 
To select a range of records, click on the first record in the 
range, then press and hold the SHIFT key, then using the 
mouse select the last item in the range by clicking on that 
item. The range is highlighted and all items are selected for 
action. 
 
To randomly select multiple records press and hold the 
CTRL key, using the mouse click on the desired records. 
The selected items are highlighted and are ready for edit. 
 
To unselect the items, release the shift or CTRL key and 
click on an item outside of the highlighted group. 
 

Once items are selected locate the node on the Search Tree that items 
are to be linked. From the List View, click any selected record with 
the left mouse button, hold the mouse button and drag and drop the 
records to the desired node on the tree.  
 
Link to Tree Button – First select a node on the Search Tree, when 
selected it will be highlighted. Then find and select the desired items 
in the List View window. Press the Link to Tree button.  
 
The Right Mouse and the function key F-12 do the same as pressing 
the Link to Tree button. 
 
Link All to Tree Button - First select a node on the Search Tree, 
when selected it will be highlighted. Then search for items in the 
database, if the all items found in the search are to be linked to the 
selected node on the Search Tree press the Link ALL to Tree button. 
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Run Search Tree  
 
To verify the product assignments press the Run Tree button. This 
will shift the search control to the Search Tree.  The Search Tree will 
now locate items that were linked to the tree. When a branch is 
selected all items associated with that branch are displayed, when 
branches are opened to follow the search is narrowed.  The view and 
functionality of the Search Tree in Quik-Price Builder is the same for 
Quik-Price and Quik-Irr.   
 
 
 

Search Tree Editing 
 
Changes can be made anytime to the Search Tree. Editing can either 
involve: 
 

• Change the Search Tree Structure 
• Change Links 
 
 
 

Edit the Search Tree Structure 
 
Go to the Tree Builder. Once items have been linked to the Search 
Tree the editing will run slower. Changes made to the Search Tree 
structure are automatically changed in the product database 
 
Move a Branch - To move a branch, position the cursor over the 
branch to be moved.  With the left mouse button click, hold and drag 
to another position.  To move a branch to the Root position, drag it to 
the bottom of the list. Release the left mouse button; you will then be 
prompted to confirm the move. The branch and all sub-branches will 
be moved together.  Products already linked to the branch will be re-
linked to the new position.  
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Add - New Root positions and branches can be added by using the 
icons or the options found using the right mouse button. (For more 
information refer to the Tree Builder) 
 
Delete - When deleting branches from the tree, select the branch and 
use the delete icon. All sub-branches are also deleted. The program 
also searches and deletes tree assignments, so a delete can take 
several minutes. 
 
 
Change Links 
 
Reassign Products - Once an item is assigned to the tree the same 
item can be reassigned to any new position. Follow the same process 
when items were originally linked, the original link is overwritten. 
  
Remove Product From Tree - To unlink a product press F-11 or use 
the Remove from tree option found when clicking the Right mouse 
button.   
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10. Import Update 
 
Update Database 
 
There are constant changes in pricing and products. Price updates are 
separate from product updates.  To update prices simply re-import the 
price fields. A product update is used to: 
 

• Add items 
• Import to all or selected fields  

 
The process to update the database is very similar to the original data 
import. Follow the same procedure to create an export file form the 
system computer.  For more information refer to chapter 2. 
 
 

 



Import Update 
 

 61 

���������	
����
	� 

There is one key element to a successful update. There must a link 
between the existing database and the database to be imported. This 
field is use to identify the same item so it is updated with the correct 
corresponding data. The product ID is the recommended link field. 
This field should have been a part of the original import.  
 
The import update process involves several steps: 
 

1. To begin, go to Import / Import Update of chose Import 
Update from the Flow Chart. 

2. The Import Update Properties screens with two options: 
a. Add New Products – by checking this box items not 

linked to the existing database will be treated as 
new items and will be added. By not checking the 
box no new items will be added. After running the 
update a list of items that would be added will be 
displayed. 

b. Link on – select the field that will be used to link 
the database between the existing database and the 
file containing the updated information.  

 
Enter the choices and press close. 
 

If an Import Script was saved when doing the initial import, open the 
import script. The file must have the same name and have the same 
structure The Open Import Settings button can be used to locate this 
file. By opening this file all the setup options will automatically be 
loaded. Skip to step 7 and press the Run Import Update button. 

 
3. Select the file type from the pull-down menu. The file type 

must match the format of the file exported from the system 
computer. 

4. Locate the file containing updated data and press open. 
5. Once the file is opened the contents of the file are displayed. 

If the data is not clearly displayed in columns some of the 
options may need to be changed in the Import Properties. 
For more detail see chapter 2. 

6. Now associate the data column with the fields needed by 
Quik-Price Builder. Use the pull down list by each data field 
to select the name of the field that corresponds to each field. 
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7. Press Run Import Update.  Quik-Price Builder will begin 
importing the data and updating the selected fields.  

8. After the update has been run a New Products Added screen 
opens displaying the new products that were either added or 
would have been added had the add option been selected. If 
the Add option was not selected and there are some items 
that need to be added, those items may be selected and the 
Add button may be pushed. The other option is to add all the 
items in the list.  

9. Now SAVE the import update script to file all the choices 
made. Press the Save icon and name the import script. This 
script can be opened later to refresh all the options when you 
need to import prices or run an import update. 

 
There may need to be additional editing, categories may have been 
added, new products may need to be linked to the Search Tree and/or 
Product Information files.  
 
 
NOTE: After updating the database, re-run the Create Load files 
utility.
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11. Product Info File Link 
 
 
Many manufacturers provide product information in an electronic 
format. One very common format is Abode Acrobat files that can be 
viewed and printed using Abode Acrobat Reader®. Quik-Price 
Builder can be used to create a link to these files.  When Quik-Price 
and Quik-Irr users pull up an item in the database a Product Info Link 
icon will be displayed indicating a link. Pressing that icon will launch 
the viewer and open the file.  
 
There are three main steps to this process: 

• Build a Product Information Library 
• Links Products to the library 
• Distribute the library to users 

 
 

Build a Product Information Library 
 
A Product Library is made up of files containing graphic and or text 
information. The program is not limited to PDF files. Windows 
associates file types with specific programs. For example a PDF file 
is associated with Adobe Acrobat®. When a PDF file is opened, 
Windows knows to first open the Adobe Reader®. There are other file 
types that are very common as well: 
 

• HTM / HTML – web files that can be opened in a web 
browser such as Internet Explorer® or Netscape® 

• BMP – bitmap images opened by many graphics programs 
• A link can also be established to a website, if a website 

address is entered that includes HTTP://www.  
 
Start by creating a folder (directory) location on the computer hard 
drive that will contain these files. Create as many sub-folders (sub-
directories) as needed to organize the files. Obtain copies of the 
desired files or create files using a scanner and graphics-editing 
program.  
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Included on the Quik-Price Builder CD is a sample library containing 
PDF files from several manufacturers in the irrigation industry. 
Permission has been received to freely copy and distribute these files. 
Move them to the hard drive and these files can be used as a 
beginning point for a library. Add or delete as needed based on the 
needs of your market. 

 
Link Products to the Library 

 
 

 
 
Once library has been built, products in the database can be linked to 
the library. There are several steps to follow: 

1. Go to the Settings pull-down menu and select Folder 
Locations. The location of the library must be set. Enter the 
path or use the browser button to locate the folder that 
contains the library. Press OK 

2. Now open the Product Info Link mode, this can be done 
from the button at the top of the screen, the Flow Chart or 
the View pull-down menu. This mode opens the List View 
and a file explorer. 

3. First locate and select the Product Information file that is to 
be linked.  At the top of the File Explorer there is a browse 
button that can be used to open the folders that contain the 
files that are to be linked. A list of files is displayed. 
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4. Next use the search tools to locate and select items in the 
database to be linked to the selected file.  Selected items are 
highlighted, more than one item may be selected using the 
CTRL key or the SHIFT key. 

5. With the file selected on the left and products selected on the 
right press either the Link to Product Data Sheet button or 
the Link ALL to Product Data Sheet button.  

 
To test the link, selected an item that has been linked and double click 
on the item to open the Form View. The link file name can be seen at 
the bottom of the form view. Press the Product Info File button. This 
will launch the associated program and open the file. 
 
Import Product Info Links 
 
Some of the files on the Quik-Price Builder CD have been linked to 
items in the Wizard Links to this database can automatically be added 
to the database. This utility will only link items that have been found 
using the Wizard Match. Not all items will have a link.  This utility 
will overwrite existing links. This utility is provided as a convenience 
and a beginning of a product information library. Not all the 
manufacturers have contributed to the library. Add to the library and 
create links items in the database. 
 
 

Distribute the library with users 
 
A Load file given to Quik-Price and Quik-Irr users will contain the 
file link but NOT the file itself. The library will contain many files. 
The best way to distribute these files is to copy them to a CD using a 
CD burner. Users will be able to access these files from the CD or 
they can be copied to the hard drive of their computer. Access to 
these files is NOT limited to just Quik-Price and Quik-Irr users. 
These files may be opened and used in other applications. 
 
The library files should be updated to provide current information and 
the links managed as new products are added. New copies of the 
library should be distributed as changes are made. 
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12. Reports 
 
There are several predefined reports that can be printed. In addition 
reports can be modified or created using Quik-Word. The print button 
can be activated from the following screens: 
 

• List View – ALL items currently filtered will be printed. In 
most cases a list view report should only include a filtered 
list of selected items. Be careful a report of 10,000 items will 
take a long time. 

• Categories – Includes both the category name and code. 
• Search Tree – Complete tree structure for review. 
• Selected Branch – This report included both the tree 

structure and the items linked to the Search Tree. This 
printout will include selected branches. 

• Orders – Customer orders. 
 
When the print button is pushed a list of available forms is displayed. 
Quik-Price Builder comes with several predefined forms that can be 
selected. Additional forms may be added to generate customized 
reports. Select from a form and press either: 
 

• Preview 
• Print 
• Edit 
• New Printout 
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Print Preview 
 
A print preview provides a view of the document before sending it to 
the printer. Once the preview screen is open there are several options: 
 

• Close – Press to close preview screen. 
• Zoom in / out – Use these two buttons to control the size of 

the document as it appear on the screen, either larger or 
smaller. It does not affect the actual size of the printout. 

• Back / Next – Use to advance the view to subsequent of 
previous pages. 

• Edit – Opens the document for editing in Quik-Word. The 
basic word processing functions are there to make changes 
to the report before sending it to the printer. 

• Print – Send the document to the printer. 
• Print Setup  - Select a Windows printer, paper size and pager 

orientation, either portrait or Landscape. 
 
 
Print 
 
This print button sends the report immediately to the printer. 
 
  
Edit 
 
There are two levels of editing. From the preview screen the report 
may be opened for editing using Quik-Word. The edit option from the 
printout screen allows the report format to be changed.  
 
 
New Printout 
 
A new report format may be created using Quik-Word. This form 
may be saved for reuse. 
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Quik-Word 
 
Quik-Word may be used to edit a report after it has been previewed or 
to edit, customize of define reports. Quik-Word is a word processor 
with the tools needed for Quik-Price Builder reports but may also be 
used for other word processing functions. 
 
 
 

 
 
 
 
The following tools are available in Quik- Word. 
 
File 
 
New – Start a new blank document 
 
Open – Open an existing file. A file browser opens to assist in 
locating the file. 
 
Save – Save the current document. Files are saved as Rich Text 
(RTF) and can be opened by most word processors 
 
Save As – Save the current document with a different name. The file 
type may also be changed to HTML or a text file. 
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Insert File - Insert document into an open document.  

1. Click where you want to insert the second document.  
2. On the file menu, click Insert File.  
3. In the File name box, enter the name of the file to be 

inserted. 
 
Print Preview – View the document as it will be printed. 
 
Print  - Sends the document to the printer 
 
Print Setup – In the Print Setup dialog box, do any of the following:  

• To select a different printer, click the pull-down menu.  
• To change the paper source, click a tray name or a feeder in 

Source.  
• To print the document vertically, click Portrait; to print the 

document horizontally, click Landscape.  
• To change printer settings, click Properties. 

 
 
Close – Exit Quik-Print and return to Quik-Price Builder 
 
 
Edit 
 
Undo - To undo the last action, click Undo 
 
Redo - To repeat the last action, click Redo 
 
Cut  / Copy / Paste  - Use to cut, copy, or paste text. 

• To cut text to move it to another location, select the text, and 
then on the Edit menu, click Cut.  

• To copy text to paste it in another location, select the text, 
and then on the Edit menu, click Copy.  

• To paste text that was cut or copied, place the insertion point 
where the text is to be pasted, and then on the Edit menu, 
click Paste.  
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Find / Replace - To find or replace specific characters or words, 
search for words or characters in the document. Search for and 
replace words or characters with text as needed. 
 
Select All - Select all text at once by clicking Edit, and then clicking 
Select All. 
 
Insert 
 
Symbol - Click where the symbol is to be inserted.  

1. On the Insert menu, click Symbol, and then click the 
Symbols tab. 

2. In the Font box, click the desired font. 
3. To get a close-up view of a symbol, move the mouse over it.  
4. Double-click the symbol to be inserted.   

 
Graphic on Disk - Click where the graphic is to be inserted.  

1. On the Insert menu, click Graphic on Disk. 
2. Type or browse to the path and file name in File.  
3. Press open to insert the file. 

 
Table - A table is made up of rows and columns of cells that can be 
filled with text. Tables are often used to organize and present 
information, but they have a variety of other uses as well. Use tables 
to align numbers in columns. 
 
There are two ways to add a table.  

1. From the Insert Menu select Table. 
a. Enter the number of columns and rows. 
b. Alignment selects the position of the table on the 

page, left, right or centered. 
c. The borders option adds a single line around each 

cell in the table. Lines can be edited later. 
d. Table width defaults at 100% of the margin width. 

2. The Table button can be used to quickly add a table, 
a. Use the mouse to drag to control the number of 

columns and rows. 
b. Turn borders on or off with the border button. 
c. When ready, click the check to insert the table. 
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Table Options 
 
Table Control Buttons - There are several buttons that can be used 
to control the look of a table: 
 
Select Row or Column –  

1. Place the cursor in a cell. 
2. Press the Select Row or Column button. 
3. Make any changes needed to the row or column. 

a. Add borders 
b. Modify the text position 
c. Add Color 
d. Change font or text size 

 
Insert Row or Column 

1. Place the cursor in the cell where a new column or row 
needs to be added. 

2. Press the Insert Row or Column button. 
 
Delete Row or Column 

1. Place the cursor in the cell of the column or row to be 
deleted. 

2. Press the Delete Row or Column button. 
 
Split Cell  

1. Place the cursor in the cell to be divided into two cells.  
2. Press the Split Cell button. 

 
Join Cell  

1. Select the cell or cells to be combined into one cell.  
2. Press the Join Cell button. 

 
Resize Columns   

1. Position the cursor on the line dividing two columns; the 
cursor will change to opposing arrows.  

2. Press and hold the left mouse and drag the column line to a 
new position. 

 
Color and Borders - Enhance the table by adding borders and filling 
cells with colors.   
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1. Select the cell or cells to add color or borders.  
2. Press any of the border line option buttons or the cell color 

button. 
 
Note: When building a report that contains lists of items that will 
come from the database, a table must be used as the location to insert 
a field that contains multiple items. The length of the field 
automatically adjusted when the report is generated. 
 
Format 
 
Font - To change a font type, style, or size  

1. Select the text to be changed.  
2. On the Format menu, click Font.  
3. Click the desired options. 

  
Note: Before typing, specify the font for new text by changing the 
font settings. Or select all text at once by clicking Edit, and then 
clicking Select All. 
 
Paragraph – Change paragraph format options include: 

• Alignment - left, right or centered 
• Indentation - dimensions from the left or right. The first line 

indentation may be separate. 
• Line Spacing 

 
 
Borders – There are two ways to format lines and colors in a table.  

1. From the Format pull-down select Borders and Lines screen 
to define the borders. 

a. The line style and width may be selected. 
b. Spacing around the text can be set. 
c. Fill shading. 
d. There is control over each line of the border. 
e. The preview button displays the borders for review. 

2. There are several border buttons positioned on the tool bar to 
quickly modify the table borders. 
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Tab Stops - In the Tabs dialog box, do the following:  
• To set a tab stop, set the measurement for a new tab stop in 

Tab stop position, and then click Insert.  
• Select the tab alignment, left, right centered or on the 

decimal position 
• To delete a tab stop, click it in the list, and then click Delete.  
• To delete all tab stops in the selected paragraph, click Delete 

All. 
 
Bullets - Click where the bulleted list is to start.  

1. On the Format menu, click Bullet Style,  
2. Then type the text. 
3. Press ENTER and, another bullet appears on the next line.  
4. To end the bulleted list, on the Format menu, click Bullet 

Style again. 
 
Page Layout - In the Page Setup dialog box, do any of the following:  
 

• To change the paper or envelope size, click a size in Size.  
• To change the paper source, click a tray name or a feeder in 

Source. 
• To print the document vertically, click Portrait; to print the 

document horizontally, click Landscape.  
• To change the margins, type a width in any of the Margins 

boxes.  
• To change printer settings, click Printer. 

 
Fields 
 
To access the information in the database fields must be selected and 
inserted into the document. There are several tables in Quik-Price 
Builder that can be accessed: 

1. Products – All the product data that can be seen in the form 
view. 

2. System \ Supplier 
a. Date, time and page numbers 
b. Supplier Information 
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Go to the Fields pull-down menu and select a table. A new toolbar 
displays the tables. To add fields to a report: 
 

Note: Any data that is in a list format can only be put in a table. 
Products and PO products are list type data tables. All other table 
data can be inserted at any location in the document, including 
tables. 

 
1. Begin by deciding where the data is to be displayed. Create a 

table if needed. Position the cursor at the insertion point. 
2. Using the table pull-down list select the field to be inserted 
3. Press the Insert button to add the field to the document 

 
Only the field name is displayed in the document. When the report is 
run from a print command the selected data will be included in the 
report. 

Note: Care must be taken when building forms. A document 
CANNOT access data from both the PO tables and the 
product tables. 
 

Purchase Order Forms 
 
Form Builder is a report generator is used to create or modify a form 
used to generate a printout. A form is used to control the look and 
content of the report. Select the fields that will be included, the 
position and font of the text. Grid lines, boxes, color and other text 
may be added to customize the report. Once a form has been defined 
it may be selected from the Project printout screen to be used to build 
the report. 
 
Due to the complexity of the using the form builder it is 
recommended that you select a form that is closest to meeting your 
needs, open it, press Save As and edit the newly saved form. 
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Fields 
 
When building a project there are product lines, headers subtotals etc. 
There are also many columns that may or may not need to be 
included in the printout. In addition there is general information about 
the project, the company and supplier. The Form builder in Quik-
Word lets you select the fields, set the layout, font, grid lines and 
colors, to make a report look the way you want. To accomplish this 
there are several steps to understand: 
 

• Headers and Footers  
• Using Tables 
• Frames in the Body of the Document 
• Fields from Orders 

 
Header and Footer 
 
Text, tables, fields or graphics included in the header and footer are 
displayed on every page of the document. Keep use of this area to a 
minimum to save room for the body of the document.  
 
Note: Footer text etc. should be positioned at the top of this page, the 
report builder will see that it gets to the bottom of the page. 
 
Using Tables 
 
Tables are a key part of adding items to a form. Some fields must be 
assigned within a table other fields can be either in or out of a table. 
Any field from the Project Table list must be put in a table. The table 
is the key to having the form act dynamically. The contents of a table 
can cause the table to grow as needed to include all the text. 
 
The appearance of a table can be controlled to customize the look.  

• Borders can be turned on or off. 
• Text position within each cell can be set.  
• Color can be added to a cell or group of cells 
• Font style, size and color can be changed 
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See Format options on how to use these options. 
 
There are two ways to add a table: 

• Table button 
• Table from the Insert pull-down menu 

 
See Table options for more information. 
 
Frames in the Body of the Document 
 
There are several frames in the body of a form. These frames will 
look to specific parts of a project for data and specific parts of the 
document to place data. 
 
First Page Only – Text, graphics, tables, or fields that only need to 
be on the first page. The contents of this frame are put AFTER the 
page header; the page header shows up on the top of every page. Its 
contents are displayed before the contents of the “Top of every page” 
frame. 
 
Top of every page – This frame is primarily intended to for column 
headings. Fields cannot be put in this frame. It is positioned below the 
header and first page frame.  
 
Standard Item  - Every project contains products or items that make 
up the material list. Put the fields that need to be included from the 
project in this frame. The Fields’ window includes all the fields 
associated with a Project. For this frame only select items under the 
“Project Table” fields. Do not use text, unless the text is to be 
repeated for every line in the project. 
  
Header – If headers were used in the Project, that type of data will be 
looked for. Typically all you will need to include is the “Description” 
field from the Project Table fields. The font, position or background 
color can be changed to give variety to the report. Do not use text, 
unless you want the text repeated every time a header is used in a 
project. 
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Header Subtotal - If header subtotals were used in the Project, that 
type of data will be looked for. Typically all you will need to include 
is the “Description” field and one of the Total fields found in the 
Project Table fields (Note: do not use the “Project Totals” fields, use 
the project Table totals). The font, position or background color can 
be changed to give variety to the report. Do not use text, unless you 
want the text repeated every time a header is used in a project. 
 
Subtotal - If subtotals were used in the Project, that type of data will 
be looked for. Typically all you will need to include is the 
“Description” field and one of the Total fields found in the Project 
Table fields (Note: do not use the “Project Totals” fields, use the 
project Table totals). The font, position or background color can be 
changed to give variety to the report. Do not use text, unless you want 
the text repeated every time a header is used in a project. 
 
Comment Line - If comment lines were used in the Project, that type 
of data will be looked for. Typically all you will need to include is the 
“Description” from the Project Table fields. The font, position or 
background color can be changed to give variety to the report. Do not 
use text, unless you want the text repeated every time a header is used 
in a project. 
 
Summary – At the end of the document add the “Project Totals” 
fields. This will be positioned on the last page of the document and 
above the Page Footer. This frame can include text and graphics in 
addition to the totals fields. 
 
 
Fields from Orders 
 
There are many data fields available to be included in a form. To 
access the information in the project, fields must be selected and 
inserted into the document. There are several database tables in Quik-
Irr that can be accessed. Go to the Fields option found in the Insert 
pull-down menu. A new window displays the fields. To add fields to 
a report: 
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1. Begin by deciding where the data is to be displayed. 
Create a table if needed. Position the cursor at the 
insertion point. 

2. From the Fields window select the field to be inserted. 
3. Press the Insert Field button to add the field to the 

document. 
 
Note: Any data that is in a list format can only be put in a table. 
Products are list type data tables. All other table data can be inserted 
at any location in the document, including tables. 
 
Only the field name is displayed in the document. When the report is 
run from a print command the selected data will be included in the 
report. 
 
When changing the font or text size the field name appearance does 
NOT change. When the cursor is at the field the text font settings are 
shown in the font settings control. 
 
The following is a list of available fields with some notes explaining 
the data contained in the field. 
 
 
 

1. System 
a. Date – These dates come from the computers 

calendar. There are several different formats. 
i. Date (mm-dd-yyyy) 

ii. Date (mmm dd yyyy) 
iii. Date (mmmm dd, yyyy) 
iv. Date (mm/dd/yy) 
v. Date (mm/dd/yyyy) 

vi. Date (mm-dd-yy) 
b. Time – The time come from the computers clock. 

There are several different formats. 
i. Time (hh:mm am/pm) 

ii. Time (hh:mm) 
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2. Project – These fields hold information about the project, 
job information, products, prices and quantities. 

a. Project Information 
i. Title 

ii. Bid Number 
iii. Project Number 
iv. Date 
v. Prepared For 

vi. Contact 
vii. Address 

viii. Address 2 
ix. City 
x. State 

xi. Zip 
xii. Phone 

xiii. Mobile 
xiv. Fax 
xv. Email 

xvi. Notes 
b. Project Tables – These fields hold all items in the 

material list. Much of this data comes from the 
supplier database as items are added to the project. 

i. #  (Line number) 
ii. Quantity 

iii. Item Code 
iv. Product Codes 

1. Product Code 1 
2. Product Code 2 
3. Product Code 3 
4. Product Code 4 
5. Product Code 5 
6. Product Code 6 
7. Wizard Code 

v. Description – Note: This field is also used 
to hold the description for each product 
AND text used in the Headers, Subtotals 
and Comment lines. 

vi. Secondary Description 
vii. Package 

viii. Category Code 
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ix. Category Name 
x. Sequence 

xi. Size 
xii. UPC 

xiii. Product ID 
xiv. Units Per Item 
xv. Cost Fields – These are line item values. 

See Project Totals for the grand total 
fields. 

1. Cost 
2. Total = Cost x Qty  
Note: This field is used for a line item 
extended total AND for the Subtotals. 
3. Tax = Total x Tax 
4. Cost+Tax = Cost + (Cost x Tax) 
5. Total w/Tax = Cost+Tax x Qty 
Note: This field is used for a line item 
extended total AND for the Subtotals. 
6. Taxable 

xvi. Sell Fields – These are line item values. 
See Project Totals for the grand total 
fields. 

1. Sell 
2. Total = Sell x Qty  
Note: This field is used for a line item 
extended total AND for the Subtotals. 
3. Tax = Total x Tax 
4. Taxable 

xvii. Gross Profit 
1. Percent 
2. Amount 

 
c. Project Totals – These are used as the summary 

totals for the project. Do not use these for line item 
totals. 

i. Cost 
1. Total 
2. Tax 
3. Total + Tax 
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ii. PO 
1. Total 
2. Tax 
3. Total + Tax 

iii. Gross Profit 
1. Percent 
2. Amount 

d. PO Information 
i. PO Number 

ii. Order Type 
iii. Ship To 

1. Contact 
2. Address 
3. Address 2 
4. City 
5. State 
6. Zip 
7. Phone 
8. Mobile 

iv. Notes 
 

3. Supplier Information 
a. Company Name 
b. Address 
c. Address 2 
d. City / State / Zip 
e. Web Site 
f. Phone 
g. Fax 
h. Mobile 
i. Branch ID 
j. Region 
k. Contact 1-5 

i. Name 
ii. Position 

iii. Phone 
iv. Mobile 
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4. Company Information 

a. Contact 
b. Company Name 
c. Address 
d. Address 2 
e. City 
f. State 
g. Zip 
h. Phone # 
i. Fax # 
j. Email Address 
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13. Orders 
 
 
Quik-Price Builder can receive, open and process files that contain 
orders generated using Quik-Price or Quik-Irr. These files can be 
reviewed and exported to other computer programs. The orders may 
also be printed.  
 
To use the Quik-Price Builder order system it is important to 
understand how order files can be received and processed.  
 
Order files are received several different ways. 
 Quik-Order 
 E-mail file attachment 
 Files exchanged on a disk or across a network. 
 
Whatever method a file is received it should be saved in the Pending 
Order folder in Quik-Price Builder.  An order file will have a file 
extension *.QPO. 
 
 

Quik-Order 
 
Quik-Orders is a separate program that receives both direct Internet 
orders and e-mail orders from Quik-Price and Quik-Irr users. It is 
included on the Quik-Price Builder CD. To automatically receive 
orders this program must be running at all times. It is a small program 
that runs in the background. Include the program in the automatic 
Start menu in Windows. Once the program is running it can be 
accessed from the Windows System Tray. There are some general 
settings associated with the program and settings for both e-mail and 
direct Internet orders.  
 
General Options Settings 
 
There are two settings in general options; new order sound and file 
save location. 
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New Order Sound – When the program receives an order a New 
Order alert message is displayed on the screen, click new order to 
acknowledge the order. Use Quik-Price Builder to view the order. 
The program can also activate a Windows wave or Midi sound file. 
The new order alert sound runs until the new order is acknowledged. 
Use the file browser to locate and select a wave file. The sound can 
be tested using the run, pause and stop buttons.  
 
Save Location – An order is received as a file. The program needs to 
know where the file is to be saved. The default location used by 
Quik-Price builder is c:\Program Files\Quik-Price Builder\Pending 
Orders. Use the file browser to select the location. Quik-Price Builder 
is used to open these files. Files may be saved to a network location 
or another folder.  
 
Direct Orders Settings – Orders can be sent directly to this program 
via the Internet (the customer is not going to a website nor is a web 
browser is not used). The computer must be on an Internet server that 
has a static IP address. In most cases if a system is using a firewall 
Quik-Order will need to operate outside the firewall.  There is a check 
box on this screen that can used to disable the direct order 
monitoring. To re-enable the program must be restarted.  
 
The program looks at the computer’s current IP address. This must be 
a static IP address. A port setting of 6711 is the recommended default 
value. These same settings are entered in the Supplier Information 
screen under, Order Settings. If enabled these settings are included 
with the Load file given to Quik-Price and Quik-Irr customers. These 
embedded settings make it easy for customers to send an order via the 
Internet.  When an order is sent via the Internet the program looks for 
an Internet connection and sends the order directly to Quik-Order. 
The order is received by Quik-Order and an immediate confirmation 
is sent to the remote computer verifying that the order was received. 
 
E-mail Orders – Orders may be received via e-mail. When using the 
direct Internet order system it is recommended that the e-mail system 
be configured. Some customers may choose to send the order via the 
email system in Quik-Price or Quik-Irr.  
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If there is not a computer setup as a server on the Internet the email 
order system may be used. E-mail may not be as fast or reliable as a 
direct Internet connection, but provides a system that will work. Also 
there is no automatic confirmation to the user when an order is 
received.  
 
To receive orders via email the mail server settings must be entered. 
 
E-mail address / User ID – this is typically the e-mail address but 
does not typically include the @xxxxx.xxx. It is recommended that a 
separate e-mail account be established for orders only. This e-mail 
address is included with the load files when entered in the Supplier 
Information order settings. 
 
Password – When an email account is established there is typically a 
password. 
 
Host – Enter the name of the POP 3 e-mail server that hosts the e-
mail account 
 
Port – The incoming e-mail port setting is typically 110 
 
Check E-mail every – Enter how often the e-mail account is to be 
checked for orders. 
 
To use the e-mail order process customers should use the e-mail order 
system in Quik-Price or Quik-Irr to send orders. They do not need to 
use a separate e-mail program.  If customers prefer to send the order 
as a file attachment, Quik-Order will receive the order.  
 
If the Quik-Price e-mail order system is not used, customers can still 
send an order via e-mail to the address included in the order setting. 
An e-mail program such as Microsoft Outlook can be used to access 
the account an open the e-mail. An e-mail order sent with Quik-Price 
or Quik-Irr includes both text that displays the order and a file that 
can be opened with Quik-Price Builder.  An e-mail program may be 
used to view the order. The attached file can be saved to the Pending 
Orders folder. 
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Orders Received  
 
Quik-Order will display the received files. A file name is given that 
includes the company name and a sequence number. The counter is 
used to advance the sequence used in the file name.  
 
The error log and last packet received screens are for diagnostics. If 
errors occur the log should provide sufficient detail to understand and 
correct the problem. If the problem persists, contact Irrisoft customer 
support. 
 
 

Order Processing 
 
Order processing involves four steps: 

• Open  
• Review and edit 
• Export or print 
• Complete the order 

 
 
1. Open a Pending Order  
 
The file explorer, on the upper left, can be used to select and open an 
order.  
 
2. Review 
 
The order file contains information about the company sending the 
order, specific purchase order information in addition to the items 
needed in the order. 
 
Customer Company Information – Company information in the 
Quik-Price or Quik-Irr is included with the information contained in 
the file. The name of the supplier database used to create the order is 
also included. 
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Purchase Order information – Information on this screen can 
provide details such as PO number, shipping information and any 
notes from the customer. 
 
Order – In the order tab are all the items included in the purchase 
order. 
 
Check order for Non-stock items - Before processing the order it 
should be checked. In theory items on the order should have the same 
part numbers as in the companies’ computer system. To verify the 
order press the “Check order for non-stock items” button (the check 
mark button). This utility will compare the part numbers in the order 
to the part numbers in the current database. Items NOT found in the 
database will be highlighted in yellow. These items should be 
reviewed and edited if needed, 
 
Edit order – Items may be added or edited. Enter the product code or 
use the available search tools at the top of the screen to locate an 
item. The list view on the right displays the search results and an item 
may be added to the order by using the drag and drop method.  
 
The same Project tools in Quik-Price are available. Headers, 
comments may be added, but generally are not needed.  
 
When the order is edited the cost is not added. The program does not 
know which price level is used. The primary intent of this program is 
to receive an order that can be entered into the supplier’s order entry 
system. The fastest way to do this is to create and run an export 
script. 
 
 
3. Export Orders 
 
An export script offers control to select fields and commands to 
export the data in an order for use in other programs. A script must 
first be written then it can be run.  
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Export Method 
 
There are three export methods or format options. 
 
Copy to Clipboard – This method uses the Windows Clipboard as 
the target to receive the data sent when the script is run.  Data sent to 
the Clipboard can be pasted to other applications.  
 
Save to Text File – The data may also be sent to a text file. The file 
name must be entered. It the data is saved as ASCII text. The data 
format is defined in the export script. 
 
Send to Window – The data sent to the targeted window. The script   
sends the selected data as keystrokes to the target window. The 
window name (this name must be exact) and the pause between 
characters must be set. The target window must be running before 
running the script. 
 
Writing an Export Script 
 
Use a script to select data from an order and add output controls. On 
the right of the screen are the fields that can be selected. The fields 
are organized in a tree structure. Click on the + to open and display 
the available fields. For a complete list and an explanation of each 
field go to chapter 12 in the section on using the Form builder. 
 
To add a field to the script, position the cursor in the script at the 
desired location. Select the field and press the Insert Field button. The 
name of the field is inserted in the script. 
 
Control characters such as ¶ (Enter) or � (Tab) can added. In 
addition text may be entered if needed in the script. 
 
There are three parts to an export script. 
 
1. Initialize – Fields and control characters entered here are sent at 
the beginning of the script. This could be used to initiate a series of 
commands and/or send project information. Project, Company or 
Supplier Information can be included here. Do NOT select fields 
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from the Project Table (the number of records in a table field can vary 
and this screen does not work with that type of data). 
 
2. Products – The script can distinguish between three different types 
of data from the Project Table 
 

Standard Products – Product codes, quantities, or other fields 
from the Project Table, together with control codes can be 
entered here. 

 
Comments and Headers  – The text for these lines in the 
project is in the “Description” field. To include this text as part 
of the script add that field from the Project Table and include 
any needed controls. 

 
Products without a Product Code (non-stock Products) – To 
understand this type of product, recognize there is a difference 
between the Item Code and the Product Code. The Item Code is 
the code entered to find a product in the database. When an item 
is found in the database the all of its Product Codes are carried 
with it and are included in the Project. If the customer manually 
entered an item there is no “Product Code”, just an Item Code. 
The order check process will identify items that are not in the 
database. The script can be programmed to respond differently 
if this type of product is found. 
 
Page options – If the target program needs specific controls 
added to advance a page based on the number of products on a 
page, set a value in the Product per Page pull-down list. Also 
add the needed controls. 
 
Note: Hidden items and subtotals are not exported. 

 
3. Finalize – This field is the same as “Initialize” only it is used to 
add fields or controls at the end of the script. 
 
Save – The script is saved to a file.  
 
Run - Selecting the file and pressing the Run button runs the script.  
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Print – An order may also be printed. Press the Print icon. Choose 
from the pre-defined purchase order forms. The order may be 
previewed or edited. A custom form may be created. See chapter 12 
on creating purchasing forms in Quik-Word. 
 
 
4. Complete the order 
 
Once the order is processed it may be saved to a “completed” folder 
location. Press the “Move to completed folder” button (red arrow). 
The file is saved in the Completed folder. Selecting the “Completed” 
box to view and open files in the completed folder. 
 

 
 
 
 



 

 



 
 

 



 

 

 


